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Safety Information

For your own safety and the safety of others, and to prevent damage to the equipment and
vehicles upon which it is used, it is important that the accompanying safety manual—
Diagnostic Safety Manual (North America) Safety Precautions book (Europe)—be read and
understood by all persons operating, or coming into contact with, the equipment. We suggest
you store a copy the book near the unit in sight of the operator

This product is intended for use by properly trained and skilled professional automotive
technicians. The safety messages presented throughout this manual are reminders to the
operator to exercise extreme care when using this test instrument.

There are many variations in procedures, techniques, tools, and parts for servicing vehicles,
as well as in the skill of the individual doing the work. Because of the vast number of test
applications and variations in the products that can be tested with this instrument, we cannot
possibly anticipate or provide advice or safety messages to cover every situation. It is the
automotive technician’s responsibility to be knowledgeable of the system being tested. It is
essential to use proper service methods and test procedures. It is important to perform tests
in an appropriate and acceptable manner that does not endanger your safety, the safety of
others in the work area, the equipment being used, or the vehicle being tested.

Itis assumed that the operator has a thorough understanding of vehicle systems before using
this product. Understanding of these system principles and operating theories is necessary for
competent, safe and accurate use of this instrument.

Before using the equipment, always refer to and follow the safety messages and applicable
test procedures provided by the manufacturer of the vehicle or equipment being tested. Use
the equipment only as described in this manual.

Read, understand and follow all safety messages and instructions in this manual, the
accompanying safety manual, and on the test equipment.

Safety Message Conventions

Safety messages are provided to help prevent personal injury and equipment damage. All
safety messages are introduced by a signal word indicating the hazard level.

Indicates an imminently hazardous situation which, if not avoided, will result in death or
serious injury to the operator or to bystanders.

A WARNING

Indicates a potentially hazardous situation which, if not avoided, could result in death or
serious injury to the operator or to bystanders.
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A CAUTION

Indicates a potentially hazardous situation which, if not avoided, may result in moderate or
minor injury to the operator or to bystanders.

Safety messages contain three different type styles.

o Normal type states the hazard.
¢ Bold type states how to avoid the hazard.
e |[talic type states the possible consequences of not avoiding the hazard.

An icon, when present, gives a graphical description of the potential hazard.

Example:

A WARNING

Risk of unexpected vehicle movement.
ﬁ * Block drive wheels before performing a test with engine running.
YWY | A moving vehicle can cause injury.

Important Safety Instructions

For a complete list of safety messages, refer to the accompanying safety manual.

SAVE THESE INSTRUCTIONS
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Using This Manual

This manual contains tool usage instructions.

Some of the illustrations shown in this manual may contain modules and optional equipment
that are not included on your system. Contact your sales representative for availability of other
modules and optional equipment.

1.1 Conventions

The following conventions are used.

1.1.1 Bold Text

Bold emphasis is used in procedures to highlight selectable items such as buttons and menu
options.

Example:

e Press the Y/v button.

1.1.2 Symbols

Different types of arrows are used.
The “greater than” arrow (>) indicates an abbreviated set of selection instructions.
Example:

e Select Utilities > Tool Setup > Date.

The example statement abbreviates the following procedure:

1. Navigate to the Utilities button.

2. Use the Thumb Pad to navigate to and highlight the Tool Setup submenu.

3. Use the Thumb Pad to navigate to and highlight the Date option from the submenu.

4. Press YIv to confirm the selection.

The solid arrows (4, », ¥, A) are navigational instructions referring to the four directions of the
Thumb Pad.

Example:

o Press the down ¥ arrow.
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1.1.3 Terminology

The term “select” means highlighting a button or menu item using the Thumb Pad and
pressing the Y/v' button to confirm the selection.

Example:
e Select RESET.
The above statement abbreviates the following procedure:

1. Navigate to and highlight the RESET button.
2. Press the Y/v button.

1.1.4 Notes and Important Messages

The following messages are used.

Notes
A NOTE provides helpful information such as additional explanations, tips, and comments.

Example:

NOTE:
G] For additional information refer to...

Important

IMPORTANT indicates a situation which, if not avoided, may result in damage to the test
equipment or vehicle.

Example:

IMPORTANT:
Do not force the CompactFIash® card into the slot.

1.1.5 Procedures

An arrow icon indicates a procedure.

Example:

E] To change screen views:
1. Select the VIEW button.
The drop-down menu displays.
2. Select an option from the menu.
The screen layout changes to the format you selected.



Additional Manuals

1.2 Additional Manuals

This tool works in conjunction with other software products. All of the required manuals are
included on the Diagnostic User’s Documentation CD, which was supplied with your scan tool
kit. See the appropriate manual for information regarding these products.
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Introduction

The scan tool uses Vehicle Communication Software and Fast Track® Troubleshooter
software to provide vehicle-specific trouble codes for various vehicle control systems such as
engine, transmission, antilock brake system (ABS) and more, selected functional tests, and
troubleshooting information. The scan tool can also graph live data parameters on-screen.

Figure 2-1 SOLUS PRO™

2.1 Functional Description

Figure 2-2, Figure 2-3, and Figure 2-4 show the external features of the scan tool.
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Figure 2-2 Front view

1— Left handgrip

2— Liquid Crystal Display (LCD)
3— S button

4— N/X (No) button

5— Y/v (Yes) button

6— Thumb Pad

7— Brightness/Contrast button
8— Power button

9— Right handgrip

Figure 2-3 Top view

1— Mini USB port

2— USB port

3— CompactFIash® (CF) Card Slot
4— DC power supply input

5— Data cable connector
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Figure 2-4 Back view

1— Stand
2— Casing hook

2.2 Technical Specifications

Display:

Liquid Crystal Display (LCD)
640 x 240 resolution

256 colors

6.2 inches (157.5 mm)

CompactFlash ® Card Slot:
The data storage CF card

IMPORTANT:
Never remove the CF card while saving data. Doing so will result in lost data.

Battery Pack:
Nickel-metal hydride
Rechargeable
Weight:

15.4 oz

437 g

External Battery Charger:
Input: 14.5-15.5 VDC, 18 watts
Output: 0-12 VDC, 1.5A

AC/DC Power Supply:
Input: 100-240 VAC @ 0.5A, 47-63 Hz
Output: 12VDC @ 1.2A

1"
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Weight:

With battery pack:
3.37 Ibs
1528 g

Dimensions:
Width:
11.85 inches
301 mm
Height:
5.63 inches
143 mm
Depth:
2.56 inches
65 mm

Operating Temperature Range:
14 to 104°F
-10 to 40°C

Storage Temperature Range:
-4 to 149°F
-20 to 65°C

Communication Protocols
Your SOLUS PRO scan tool supports the following OBD-II communications protocols:
SAE J1850 (VPW)
SAE J1850 (PWM)
ISO 9141-2
ISO 14230-4 (KWP 2000)
ISO 15765-4 (CAN)

In addition, the vehicle communications software allows you to access “enhanced”
diagnostic information for specific North American, Japanese, and Korean vehicle
manufacturers.

2.3 The Stand

The scan tool has a built-in, metal stand attached to the back. \When the stand is not in use, it
is secured to the back of the unit by an integrated casing hook (Figure 2-4 on page 11).

When extended, the stand allows the unit to rest at a 45° angle for hands-free viewing
(Figure 2-5).
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Figure 2-5 Stand extended

The stand can also be extended to a hanging position by pressing the left side towards the
right and rotating forward (Figure 2-6).

Figure 2-6 Stand in hanging position

2.4 Control Buttons

This scan tool has the following control buttons (Figure 2-2 on page 10):

e No (N/X) button

* Yes (Y/V') button

e Thumb Pad

¢ Brightness/Contrast button
e S button

e Power button

13
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2.41 N/X Button
The N/X button is used to do the following:

e To exit a menu or program.

e To close an open list and return to the previous menu.
e To answer “No” when a Yes or No choice is given.

e To return to the main menu.

2.4.2 Y/v Button

The Y/v button is used to do the following:

e To select the item you highlighted using the Thumb Pad.
e To answer “Yes” when a Yes or No choice is given.

2.4.3 Thumb Pad

The Thumb Pad moves the highlight, allowing vertical and horizontal on-screen movement.
The Thumb Pad is typically used in combination with the Y/v" and N/X buttons.

2.4.4 Brightness/Contrast Button

The Brightness/Contrast button opens the dialog box that allows you to adjust the screen for
optimum viewing. See “Adjusting Brightness and Contrast” on page 27 for details.

2.4.5 S Button

The S button can be customized to perform different functions from the Utilities > Tool Setup
menu. See “S Button” on page 76 for details.

2.4.6 Power Button

The Power button powers on and powers off this scan tool. See “Powering On the Unit” on
page 25 and “Powering Off the Unit” on page 26 for details.

The Power button can also be used to force the scan tool to shut down. This feature should
only be used if the scan tool is not performing as it should, such as if the display locks-up or
data is no longer updating.

E] To perform a forced shutdown:
1. Press and hold down the Power button for five seconds.
2. The scan tool sounds a series of beeps, then turns off.
The unit can now be restarted.



2.5

2.51

2.5.2

2.5.3

254

2.6

Connections

Connections

This scan tool uses the following connections (Figure 2-3 on page 10):

e DC power adapter input
e Mini USB port

e USB port

e Data cable connector

DC Power Input

The AC/DC power supply provides power to the scan tool through the DC power input on top
of the unit (Figure 2-3 on page 10). For related information, see the following sections:

e “AC/DC Power Supply” on page 17
e “Connecting the AC/DC Power Supply” on page 24

Mini USB Port

This scan tool has a Mini USB port for connecting the scan tool to a PC.

USB Port

This scan tool has a USB port for connecting computer peripherals, such as a printer, a
keyboard, or a mass storage device.

Data Cable Connector

The connector on the data cable connects to adapters that connect the scan tool to a vehicle
for testing.

For related information, see the following sections:

e “Cables” on page 17
e “Connecting to Vehicle Power” on page 21

Power Supply

This scan tool can receive power from three sources:

e Vehicle power
e Battery pack (rechargable)
e AC/DC power supply

For related information, see “Supplying Power” on page 21.

15
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2.6.1 Vehicle Power

This scan tool can receive 12V vehicle power via the data cable either by itself or in
conjunction with the optional auxiliary power cables.

For related information, see the following sections:

e “Data Cable Connector” on page 15
e “Cables” on page 17
e “Connecting to Vehicle Power” on page 21

2.6.2 Battery Pack

The scan tool can be powered by a rechargeable nickel-metal hydride battery pack installed
in the unit behind the right handgrip (Figure 2-7).

Figure 2-7 Battery pack partially removed

The internal battery allows you to power the scan tool, identify the test vehicle, and view the
connection message prior to connecting the scan tool to the vehicle. The connection message
lets you know which cable adapters and keys are used to connect to the vehicle, and also
provides the location of the vehicle data link connector (DLC). Once connected to the vehicle
scan tool power must be provided either through the DLC or by the auxiliary power cables
when performing vehicle tests or accessing data. A no communication message displays if
vehicle power is not available to the scan tool.

IMPORTANT:

A fully-charged battery pack should be installed in the scan tool whenever you are testing a
vehicle, even though the scan tool can operate on vehicle power without the battery installed.
The battery pack compensates for voltage drops caused by engine cranking.

Battery Charger

The battery pack is recharged by an external battery charger (Figure 2-8). See “Using the
Battery Pack” on page 22 for information on charging and installing the battery pack.

The battery charger uses the same AC/DC power supply that can also be used to power the
scan tool. See “AC/DC Power Supply” on page 17 for more details.



Cables

Figure 2-8 Battery and battery charger

2.6.3 AC/DC Power Supply

This scan tool can be powered from a wall socket using the AC/DC power supply (Figure 2-9).
The AC/DC Power Supply provides a constant 12V, and must be used when updating the
scan tool software to prevent accidental power loss. The power supply also helps preserve
battery life during operations that do not require a connection to the vehicle, such as using
Demonstration mode or reviewing and managing saved data files.

Figure 2-9 AC/DC power supply

For related information, see the following sections:

e “DC Power Input” on page 15
e “Connecting the AC/DC Power Supply” on page 24

2.7 Cables

This scan tool uses the following cables:

e Data cable
e Auxiliary power cables, lighter and battery, optional.

17
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2.7.1 Data Cable

The data cable (MT2500-5000, Figure 2-10) is included with your scan tool and uses
interchangeable test adapters for connecting to vehicle diagnostic connectors.

Figure 2-10 MT2500-5000 Data Cable

Captive screws secure the data cable ends to the scan tool and test adapter. An optional data
cable extension is available.

2.7.2 Auxiliary Power Cables

Two auxiliary power cables, the Lighter Power Cable (Figure 2-11) and the Battery Power
Cable (Figure 2-12), are available as an option. The auxiliary cables are used for testing
vehicles without battery power on the diagnostic connector.

Figure 2-11 EAX0051B03A Lighter Power Cable ~ Figure 2-12 EAX0051B04A Battery Power Cable

Refer to the Accessory Guide, included with your kit, for a complete listing of accessories and
replacement parts.
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The following steps get you started using the scan tool:

1.

Familiarize yourself with SOLUS PRO controls and connections. Refer to “Control
Buttons” on page 13 for details.

Charge the battery. Allow two to three hours for charging. Refer to “Using the Battery
Pack” on page 22 for details.

NOTE:

Use battery power for Vehicle identification purposes only (example: locate the data link
connector (DLC) and identify the adapter and keys required for vehicle communication).
Always operate your SOLUS PRO with the battery pack installed.

3.

4.

When fully charged insert the battery pack in the battery slot. See “To install the battery
pack:” on page 24 for details.

Press the Power button to turn the scan tool on.

Once the tool is powered up, you can use Demonstration mode to become familiar with
scan tool navigation and functionality without connecting to a vehicle.

3.1 Demonstration Mode

The scan tool contains programs to demonstrate scan tool test capabilities without actually
connecting to a vehicle. Sample vehicles (General Motors and generic OBD-II) with mock test
results are provided to help you become familiar with menus, navigation, and basic
operations.

E] To use the General Motors demonstration:

1.

Connect the AC/DC power supply to a wall socket and to the DC Power Supply Input on
the tool. See “Connecting the AC/DC Power Supply” on page 24 for details.

Press the Power button to turn the scan tool on.

From the Scanner menu, navigate the submenus to highlight US Domestic > 1980-2006
> GM, then press Y/v' (Figure 3-1).

SOLUSFRE"

Vehicle Comm
Previous Vehicles
us D i vH Years
Asian 19802006 *
European

Global OBDI

0OBD Health Check

_Manufaciurer

- -

L DG05O7 | 01:24p R

Figure 3-1 Scanner menu selection for Demonstration Mode
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4. Press Y/v to open the GM Database.
5. Highlight Demonstration and press Y/v'.
A series of VIN and vehicle equipment requests display.

6. Press Y/v to accept the default setting for each screen request until you reach the Select
System menu.

7. Highlight any of the systems on the menu, and Press Y/v to select.
The vehicle connection message displays.
8. Press Y/v to confirm and open the system Main Menu.

9. To begin the demonstration, select from any of the menu options (example: Data Display,
Codes Menu, Functional Tests, Troubleshooter).

NOTE:
The Demonstration contains actual data captured while driving a 2001 Chevrolet Tahoe. Look
for the throttle position (TP) sensor dropout while analyzing the data in Graphing mode.

10. To exit the demonstration, press N/X until you return to the system Main Menu.

11. To return to the scan tool Main Menu, highlight the View button on the upper toolbar and
press N/X.

A demonstration program is also available for Global OBD-II.

E] To use the Global OBD-Il demonstration:
1. Highlight Global OBDII on the scan tool Main Menu and press Y/v'.

SOLUSH
Vehicle Comm
Previouws Wehicles
US Domestic ]
Asian 3

European 3

| Global 0BDII
| 0BD Health Check

0610507 | 01200 6
Figure 3-2 Global OBD-Il menu selection

2. Press Y/v to open the Generic OBDII/EOBD database.
3. Highlight OBD Training Mode and press Y/v'.

P =

Global OBDIT
Scroll to Select Diagnostic Mode

06106107 | 09:38p, A

Figure 3-3 Sample OBD Training Mode selection

4. Highlight Start Communication on the Main Menu OBD, and Press Y/v to select.
5. Press Y/v when the vehicle connection message displays.

20
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3.3

Supplying Power

6. The ECU/Protocol Information screen displays, Press Y/v' to continue.

7. Highlight any of the item on the Select Service menu, and Press Y/ to select.
Simulated test data now displays.

8. To exit, press N/X until you return to the Main Menu OBD.

9. Highlight End of Diagnose at the bottom of the list and press Y/v'.

10. Highlight the View button on the upper toolbar and press N/X to return to the scan tool
Main Menu.

Supplying Power
There are three ways to supply power to the scan tool:

e Connect to vehicle power
e Use the battery pack
e Connect to an AC adapter

For related information, see “Power Supply” on page 15.

NOTE:

To extend the life of your battery pack, always power the scan tool with vehicle power or use
the AC/DC Power Supply. The battery pack is intended to be used during the vehicle
identification process and to get vehicle connection information.

Connecting to Vehicle Power

You need the following to connect the scan tool to vehicle power:

e Data cable (MT2500-5000)
e Test adapter

For related information, see the following sections:

e “Data Cable Connector” on page 15
e “Vehicle Power” on page 16
e “Connecting to Vehicle Power” on page 21

To connect to vehicle power:

1. Connect one end of the data cable to the data cable connector on the top of the scan tool
(Figure 2-3 on page 10).

2. Connect the other end of the data cable to the appropriate test adapter. The scan tool
displays relevant adapter and key usage for the identified vehicle.

3. Connect the test adapter to the vehicle diagnostic connector. The scan tool displays the
location of the diagnostic connector.

4. Turn the ignition on.

For vehicles that do not supply power through the diagnostic connector, you must use the
optional auxiliary power cables (see “Auxiliary Power Cables” on page 18).

21
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NOTE:
Do not plug the Lighter Power Cable into the DC power input port on the top of the unit.
Vehicle power must be supplied to the test adapter for the scan tool to communicate with

the vehicle.

IE To use auxiliary power cables:
1. Connect the required test adapter to the data cable (Figure 3-4).

Figure 3-4 Auxiliary power cable connections

1— Lighter Power Cable, large end
2— Lighter Power Cable, small end
3— Vehicle test adapter
2. Plug the small end of the Lighter Power Cable into the port on the test adapter.
3. Plug the large end of the Lighter Power Cable into the socket of the Battery Power Cable.

4. Connect the clamps of the Battery Power Cable to the vehicle battery. Be sure to observe
correct polarity when connecting to the vehicle battery.

3.4 Using the Battery Pack

The scan tool comes with a rechargeable nickel-metal hydride battery pack and an external
battery charger.

For related information, see the following sections:

e “Battery Pack” on page 16

e “Battery Charger” on page 16

e “Replacing the Battery Pack” on page 81
e “Battery Pack Not Charging” on page 86

Before using the battery pack for the first time, you must fully charge it.



Using the Battery Pack

|E| To charge the battery pack:
1. Remove the battery from the scan tool:
a. Remove the right handgrip from the scan tool.

b. Press down on the retaining tab on the side of the battery pack and slide the battery
pack out of the battery slot.

2. Plug the AC/DC power adapter into the DC power jack of the battery charger.

NOTE:
Do not put a hot battery pack in the battery charger unit. Allow the battery pack to cool first. For
optimal battery charging, the ideal room temperature is 77°F (25°C) £5°.

3. \Vertically insert the battery pack into the charger (Figure 3-5).
When charging begins, a red status light displays.
4. Letthe battery pack charge until a steady green status light displays.

When the battery pack is too hot, too cold, or unable to hold a charge, both red and green
charge status lights will flash. If the charge status lights flash for more than two hours, the
battery pack may need replacing. See “Battery Pack Not Charging” on page 86.

Figure 3-5 Battery pack charge orientation

1— Battery pack

2— Battery charger
3— DC power jack

4— Charge status light

NOTE:
m A fully discharged battery pack takes four hours to charge.
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B To install the battery pack:
1. Remove the right handgrip.
2. Insert the battery pack into the battery slot (Figure 3-6).

3. Replace the handgrip.

Figure 3-6 Battery pack installation

1— Battery slot
2— Battery pack
3— Right handgrip

E] To extend the life of the battery pack:
e Before recharging the battery pack, let it become completely discharged.
A four minute warning will display before the battery pack becomes completely
discharged (Figure 3-7).

Figure 3-7 Sample low battery warning

E] To continue working after the battery warning displays:
e Connect the AC/DC power adapter.
The scan tool may not be able to communicate with the vehicle if 12-volt vehicle power is not
available to the test adapter.

3.5 Connecting the AC/DC Power Supply

The AC/DC power supply (included) provides power from a wall socket.
For related information, see the following sections:

e “DC Power Input” on page 15
e “AC/DC Power Supply” on page 17



Powering On the Unit

B To connect an AC/DC power supply:
1. Plug the 2.5 mm end of the AC/DC power supply cord into the DC power adapter input on
the top of your scan tool (Figure 3-8).

T~

Figure 3-8 DC power supply input

2. Plug the other end of the power adapter into an appropriate wall socket.

3.6 Powering On the Unit
When a charged battery pack is installed, you can power on your scan tool.

For related information, see “Powering Off the Unit” on page 26.

E] To power on the scan tool:
e Press the Power button (Figure 2-2 on page 10).
The unit beeps and the main menu screen (Figure 3-9) displays after a few seconds.

SOLUSFRO

Vehicle Comm
Previous Vehicles
US Domestic »
Asian 4
European »
Global OBDII

OBD Health Check

L 060507 | 01:24p, A

Figure 3-9 Sample main menu

1— Scanner—use to access vehicle tests
2— Saved Data—use to access files stored in memory
3— Utilities—use to access tool setup and operation functions

3.7 Setting Up to Print
This scan tool prints when connected to a compatible printers with a USB cable.

Before you can use the PRINT button in the upper toolbar, you must do the following:
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1. Set up the printer.
2. Connect a USB cable between the scan tool and the printer.
3. Configure the scan tool to print.

IE To set up the printer:
e Refer to your printer’'s documentation for powering and paper loading instructions.

IE To configure the scan tool to print:

e Select a printer manufacturer and port from the Utilities > Tool Setup > Printer dialog
box. See “Printer” on page 74 for details.

3.8 Connecting to a Computer

Connecting your scan tool to a computer for file sharing requires the use of the optional
ShopStream Connect™ software. ShopStream Connect is a free software program that can
be downloaded from the Internet at software.snapon.com.

3.9 Powering Off the Unit

Use the Power button (Figure 2-2 on page 10) to turn the scan tool off.

IMPORTANT:
Do not attempt to turn off the scan tool with the power button while it is operating in Scanner
mode. Exit Scanner mode before powering down.

IE To power off the unit:

1. Make sure you have exited the vehicle communication software as described in
“Terminating Vehicle Communication” on page 53.

2. Exit Scanner mode as described in “Exiting Scanner Mode” on page 54.
3. Press the Power button.
The Turn off dialog box displays (Figure 3-10).

Turn off

Figure 3-10 7urn off dialog box

4. Press Y/IV to turn the power off, or press N/X to cancel.
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3.10 Adjusting Brightness and Contrast

The Brightness/Contrast button lets you to adjust the screen for optimum viewing.

|E| To adjust screen brightness and contrast:

1.

Press the Brightness/Contrast button.
The Set Brightness/Contrast dialog box displays (Figure 3-11).
Select a slider control using the right » or left « arrow.

Press the up A or down ¥ arrow to increase or decrease Brightness and Contrast.

Press N/X to close the Set Brightness/Contrast dialog box when you are finished.

1 2

SN LT

Figure 3-11 Set Brightness/Contrast dialog box

1— Brightness slider control
2— Contrast slider control
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41 Screen Layout
Scan tool screens (Figure 4-1) typically include the following sections:

e The upper toolbar contains test controls.
e The main body displays menus and test data.

e The LED indicators show certain engine operating conditions that vary by manufacturer.

1\@%

fum] =
GM 1980-2006

RPM 3175 TPS (%) 0 TPS (V) 0.00

02 B1l-S1 (mV) 833 02 B2-51(mV) g8le
02 B1-3S2 (mV) 898 02 B2-52 (mV) 903

INJ PW B1(mS) 13.9

INJ PW B2(mS) 13.9

4
\F 2001 CHEVROLET TAHOE 4WD 5.3L V8 VORTEC SFI

Figure 4-1 Sample screen layout

060407 | 10:11p

1— Upper toolbar
2— Main body

3— LED indicators
4— Status bar

4.1.1 Upper Toolbar

The upper toolbar (Figure 4-2 and Figure 4-3) controls vary depending on the mode and stage
of operations. Toolbar buttons and their function are shown in Table 4-1.

e ==
(B m| ==

Figure 4-3 Sample upper toolbar—Graph view
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Table 4-1 Upper toolbar controls

NAME BUTTON DESCRIPTION
View Lets you change the way data displays
Pause |E| Stops data collection and lets you review the buffered data
Play |E| Continuously captures data and stores it in the Data Buffer
Scanner Indicates when the SCANNER screen is active
Cursor Lets you make digital amplitude measurements of graph data
Zo0m Lets you change the magnification of the data or pick the

number of PIDs displayed on-screen in the PID List view
Snapshot Lets you capture a snapshot using the PID Trigger
Save P Lets you store scanned vehicle data or save the current
= screen in memory

Print Lets you print the displayed screen
Tools . Lets you reset the Min/Max values when graphing data

Scanner Button

When the Scanner button is selected, the background of the main body turns white, indicating
that the Text view is active (Figure 4-4) and the up A and down ¥ arrows and the
Y/v" and N/X buttons are used for screen navigation.

B8 |

Main Menu (Engine)
»Data Display
Codes Menu
Functional Tests

GM 1980-2006

Generic Functions
Movies
Troubleshooter

Custom Setup

2001 CHEVROLET TAHOE AWD 5.3L VB VORTEC SFI

060407 | 10:11p

Figure 4-4 Active SCANNER screen

When you select a different button from the upper toolbar using the left € and right » arrows
in Text view, the background of the main body turns gray, indicating the screen is inactive
(Figure 4-5). See “Terminating Vehicle Communication” on page 53 for more information.




Screen Layout

50..c.. | [y o] =
GM 1980-2006
Main Menu (Engine) Generic Functions
»Data Display Movies
Codes Menu Troubleshooter
Functional Tests Custom Setup
¢ T 2 S 4 ) |
| 2001 CHEYROLET TAHOE WD 5.3L V8 VORTEC SFI , 060407 | 10:11p

Figure 4-5 inactive SCANNER screen

4.1.2 Main Body

The main body (Figure 4-6) of the screen provides prompts. The prompts guide you through
vehicle identification and task selection. Once communication is established with an
electronic control module (ECM), parameter information can be displayed.

! Ben| ole

GM 1980-2006

Select System: Airbag
»Engine Transfer Case
Transmission BCM

Antilock Brakes

2001 CHEVROLET TAHOE AWD 5.3L VB VORTEC SFI , 0610407 | 10:11p

Figure 4-6 Sample SCANNER main body

1— Main body

4.1.3 LED Indicators

Four LED indicators (Figure 4-7) appear at the bottom of the screen and show certain engine
operating conditions, which vary by manufacturer.

1 — 2 3 4

Figure 4-7 Sample SCANNER software LEDs

4.1.4 Status Bar

The status bar (Figure 4-8) at the bottom of the screen shows the test vehicle identification,
the time, the date, and a power source indicator.

2001 CHEVROLET TAHOE WD 5.3L V8 VORTEC SFI , 0610407 | 10:11p

Figure 4-8 Ssample status bar
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You can adjust how the date and time display by selecting Utilities > Tool Setup from the tool
main menu. See “Tool Setup” on page 73 for details. Power source indicator definitions are
shown in Table 4-2.

Table 4-2 Power supply indicators

Indicator Description

Power supplied by the internal battery
il
Power supplied by the vehicle

ﬁ:? Power supplied by the AC/DC Power Supply

NOTE:
Vehicle power is needed to ensure scan tool communication with the vehicle. Make sure the
vehicle power icon displays on the status bar before attempting to perform tests.

Making Selections

Use the following instructions to navigate the interface and make selections.

To navigate the upper toolbar:
e Press the left € and right » arrows of the Thumb Pad.

To navigate the main body:
e Press the up A and down ¥ arrows of the Thumb Pad.

To make selections:
1. Highlight a button or menu option.
2. Press YIv to confirm the selection.

Using Easy Scroll

Instead of using the Thumb Pad to highlight an item and the Y/v" button to select it, Easy Scroll
lets you use only the Thumb Pad arrows to highlight and select items.

Easy Scroll works in the following ways:

e The up A and down ¥ arrows navigate menus.
e The right » arrow works like the Y/v" button to confirm the selection of menu items.
e The left € arrow works like the N/X button for cancelling, exiting, and closing menus.

See “Easy Scroll” on page 78 for information on activating Easy Scroll.
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44 Screen Messages

There are three types of on-screen messages:

e Confirmations
e Warnings
e FErrors

IEI To manage on-screen messages:
e Press Y/v or N/X as indicated in the message.

4.5 Confirmation Messages

Confirmation messages inform you when you are about to perform an action that cannot be
reversed or when an action has been initiated and your confirmation is needed to continue.

When a user-response is not required, the message displays briefly before automatically
disappearing.

4.6 Warning Messages

Warning messages inform you when completing the selected action may result in an
irreversible change or loss of data.

4.7 Error Messages

Error messages inform you when a system or procedural error has occurred.
Examples of possible errors include:

e A cable is disconnected.
e A peripheral, such as a printer is powered off.
e A CompactFIash® card is inserted improperly.
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Operations

This section explains general scan tool operations and offers instructions for customizing
certain functions.

The following is an outline of basic operations.

NOTE:
The sequence of steps may vary depending on manufacturer or model of the test vehicle. See
the Vehicle Communication Software manuals for the test vehicle for detailed procedures.

1. Select the manufacturer—Select and load the software database for the manufacturer
of the test vehicle. See “Selecting the Manufacturer” on page 36.

2. Identify the vehicle—Identify the test vehicle to the scan tool by entering VIN characters
and answering questions. See “Identifying the Vehicle” on page 37.

3. Select the system—Enter the system to be tested (engine, transmission, ABS, etc.). See
“Selecting a System” on page 37.

4. Connect the scan tool to the vehicle—Follow the on-screen connection instructions to
connect the scan tool to the vehicle. See “Connecting to a Vehicle” on page 38.

5. Select the required test from the SCANNER main menu—Select tests for the vehicle
you have identified. See “Selecting from the System Main Menu” on page 38.

(use internal battery power)

Highlight the SCANNER button Highlight US, Asian, or European
(using the Thumb Pad) in the Vehicle Comm submenu

[ Power up SOLUS PRO™ ]

( Highlight and Press YN Highlight the Manufacturer nghllght the Years
to select the vehicle: (example Ford, Toyota) in the submenu
* Year, Press YN
* Make,
* Model,
* Equipment.
f . NOTE: vehicle connector location Connect SOLUS PRO™
e Veh'lcle S:ystem and the test adapter and keys to the test vehicle.
(example; Engine, ; A
L required for communication (SOLUS PRO now operates
Transmission, ABS) ;
L displays on screen. on 12V vehicle power)

[ Select from the System Main Menu Options

Codes Data Functional Tests Troubleshooter Custom Setup
(read codes in (view vehicle (consult experience | |(choose US Customary
7

ehicle memory) parameters) etz et based information) or Metric readings)

Figure 5-1 Basic scan tool operations
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5.1 Selecting the Manufacturer

Vehicle manufacturers are organized into five categories (Figure 5-2):

Asian—for vehicles produced by Japanese and Korean manufacturers
US Domestic—for vehicles produced by US manufacturers
European—for vehicles produced by European manufacturers

Global OBDIl—for any OBD-II vehicle

OBD Health Check—for any OBD-II vehicle

Each category represents a software database that includes information for a group of
manufacturers. For example, select Asian to test a Nissan, even if the model being tested is
produced in the United States.

SOLUSPRO

Previous Vehicles
US Domestic
Asian »
European b GM
Global OBDI Ford
0BD Health Check Chrysler

H Manufacturer

(060507 , 01:24p, Ao

Figure 5-2 Scanner main menu software selection

1— Scanner function

2— Vehicle Communication menu
3— Years submenu

4— Manufacturer submenu

E] To select the manufacturer:

1.

2.

3.

36

From the main menu, select Scanner.

The Vehicle Communication menu displays (Figure 5-2):

Select from the submenus as necessary.

The database loads, then a confirmation screen displays (Figure 5-3).

B | =T
GM 1980-2006
»GM Database (1980-2006) vV 11.0

Press Y: Continue

1 — 2 3 4

06105007 | 02:42a, A

Figure 5-3 Sample confirmation screen

Press Y/v' to continue.



Identifying the Vehicle

5.2 Identifying the Vehicle

After you select the manufacturer, you are ready to identify the specific vehicle to be tested.

NOTE:
[ﬂ The exact procedure varies depending on the manufacturer. Screen prompts will guide you
through the procedure.

B To identify a vehicle:
1. Once the database loads, the first vehicle identification (ID) screen displays (Figure 5-4).

2. Press the up A and down ¥ arrows on the Thumb Pad until the correct character is
shown, then press Y/v'.

B8 |

o=l

GM 1980-2006
Select 10th VIN Character

VIN: ————————— 1-—————-
Vehicle: 2001
Engine:

06105007 | 02:42a, A

Figure 5-4 Sample Vehicle ID screen

3. Continue by entering VIN characters and pressing Y/v" or N/X to answer the on-screen
questions as necessary.

Once the vehicle identification is complete, a Select System menu displays (Figure 5-5).

5.3 Selecting a System

You must select the vehicle control system you wish to test (Figure 5-5).

B To select a system:
1. Press the up A and down ¥ arrows so the cursor is at the system you wish to test.
2. Press YIv to select.

e | fom] |
GM 1980-2006
Select System: Airbag
»Engine Transfer Case
Transmission BCM

Antilock Brakes

2001 CHEVROLET TAHOE 4WD 5.3L W8 YORTEC SFI , 0600507 | 02:43a |~

Figure 5-5 Sample system selection screen

37



38

Operations

5.4 Connecting to a Vehicle

Connection instructions prompt you to connect the scan tool to a vehicle diagnostic connector
for testing (Figure 5-6).

o=l

B8 |

GM 1980-2006

Connect: OBD-II Adapter, no key
required.

Location: 16 pin connector under left
side of dash. Press Y: Continue

2001 CHEVROLET TAHOE 4WD 5.3L V8 YORTEC SFI , 0610507 | 02:43a | A

Figure 5-6 Sample connection instruction screen

Follow the on-screen connection instructions, then press Y/v' to open the system Maim Menu.

5.5 Selecting from the System Main Menu

Depending on the vehicle, a number of options may be available on the system Main Menu
(Figure 5-7). See “Using the Scanner Functions” on page 38.

e | fom] |
GM 1980-2006
Main Menu (Engine) Generic Functions
»Data Display Movies
Codes Menu Troubleshooter
Functional Tests Custom Setup G1747
2001 CHEVROLET TAHOE 4WD 5.3L W8 YORTEC SHI L 06/0507 | 02:43a |~

Figure 5-7 Sample system Main Menu

5.6 Using the Scanner Functions

System main menu options vary by make and model and may include the following:

Data Display— displays data parameter information from the vehicle control module.
selecting may open a submenu of viewing options.

Codes Menu—displays diagnostic trouble code (DTC) records from the vehicle control
module. selecting may open a submenu of viewing options.

Service Codes—performs self-tests and displays codes after performing these tests.

Functional Tests—provides specific subsystem and component tests. The tests vary
depending on the manufacturer and model.

Actuator Tests—similar to functional tests, these tests check the operation of certain
actuators, such as solenoid valves and relays.



Using the Scanner Functions

e System Tests—provides specific subsystem testing.

¢ Generic Functions—lets you access Generic OBD-II functions (1996 and newer
vehicles only).

e Movies—records vehicle data and displays previously recorded data.

e Troubleshooter—provides step-by-step procedures, integrating parameter data and
retrieving trouble codes when appropriate, for specific symptoms of the identified vehicle.

e Custom Setup—Iets you customize certain scan tool functions.

5.6.1 Data Display

Selecting Data Display on the system Main Menu has one of the following results:

e A submenu of data viewing choices displays.
e \ehicle data displays.

A submenu displays when more than one data viewing mode is available on the identified
vehicle (Figure 5-8).

B8 |

o=l

GM 1980-2006
Data Menu SENSOR DATA
»ENGINE DATA 1
MISFIRE DATA

EGR, EVAP, ACC

2001 CHEVROLET TAHOE 4WD 5.3L V8 YORTEC SFI , 0610507 | 02:55a | A

Figure 5-8 Sample data submenu

On some models, the engine must be started or cranked before data can be displayed. For
these models, a “Waiting to Communicate” message displays if the engine was not cranked
or started.

Data Screens

When a Data selection is made, the screen displays the data list for the selected module
(Figure 5-9).The items available for any control module vary from one vehicle to another.

G =
GM 1980-2006
RPM 948 TPS(%) 37 TPS(V)  1.37
02 B1-51(mV) 812 02 B2-51(mV) 742
02 B1-52 (mV) 738 02 B2-52(mV) 690
INJ PW B1(mS) 10.0 INJ PW B2(mS) 10.1
2001 CHEVROLET TAHOE 4WD 5.3L V8 VORTEC SFI , 06/0507 | 02:55a | A

Figure 5-9 Sample engine data screen
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The top line of the display remains fixed. In some cases, the second line shows the test mode
name and also indicates whether or not the vehicle can be driven during testing.

Fixing Data Lines

The Fix Line function lets you scroll other parameters into position to compare readings.
When “Fix Line” is used, the selected lines of PIDs lock in position on-screen, but the PID data
continues to update.

See “Fix Line and Release Line” on page 44.

NOTE:
Fixing data lines in the Text view is like locking parameters in the Graphs view. See “Graph
View” on page 57 for details.

Holding a Frame of Data

You may “hold” a single frame of data, which is one data transmission cycle of the vehicle
control module data stream. When a frame is held, all data is locked at the last reading before
Y/v was pressed.

Held data stored in tool memory can be printed by selecting Print Frame on the Exit menu.
See “Print Data” on page 42 for information.

To hold a frame of data:
1. Press Y/v when viewing live data.
“HLD” indicates that data is held (Figure 5-10).

G =
GM 1980-2006
RPM 2883 TPS (%) 91 TPS(V)  3.27
02 B1-51 (mV) 903 02 B2-51(mV) 894
02 B1-52 (mV) 937 02 B2-52(mV) 946
INJ PW B1(mS) 16.1 1INJ PW B2(mS) 16.1
|| 2001 CHEVROLET TAHOE 4WD 5.3L V8 VORTEC SFI , D6/0507 | 02:59a | ~p

Figure 5-10 A held frame of data

2. Scroll to review the held data values, or press N/X to exit while a frame is held and that
frame is saved in memory.

When held, the saved data will only be available in memory until you do one of the
following:

- Exit past the Resume option on the Exit menu
- Identify another vehicle
- Power off the unit
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B To clear a frame of held data:

1. Press Y/v from the held data screen.
2. Continue pressing N/X until the system Main Menu displays.

Exit Menu Options

Press N/X from any data screen and an Exit menu displays (Figure 5-11).

e | fom] |
GM 1980-2006
»Resume LED Menu
Custom Data List Fix Line 2
Print Data
Movies Press N to Exit
2001 CHEVROLET TAHOE WD 5.3L W8 WORTEC SFI , 06/0507 | 03:00a | A

Figure 5-11 Sample Exit menu

The Exit menu can contain the options discussed in the following sections:

e “Resume” on page 41

e “Custom Data List” on page 41

e “Print Data” on page 42

e “Movies” on page 43

e “LED Menu” on page 43

e “Fix Line and Release Line” on page 44
e “Clear Codes” on page 46

Resume

Selecting Resume returns you to the last data screen viewed at the same screen position
where you exited. Any data lines that had been fixed stay fixed, and any held frames of data
stay held.

Custom Data List

The Custom Data List selection is used to select specific data parameters to display. This
allows you to focus on any suspicious or symptom-specific data parameters and may allow for
a faster display update rate.

Custom Data List selections are retained in the tool memory until a new vehicle ID is entered
or another vehicle control system is selected for testing.

NOTE:
If a parameter is not selected for display in the Custom Data List, it will not be displayed when
you enter Troubleshooter.
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B To select a custom data list:
1. From the Exit menu, select Custom Data List.

The Data Selection screen displays. An asterisk (*) next to a parameter title indicates that
parameter is selected for display (Figure 5-12).

B8 |

o=l

GM 1980-2006

»DISPLAY DATA
DESELECT/SELECT ALL
02 B1-S51(mV)

*02 B2-51 (mV)

2001 CHEVROLET TAHOE 4WD 5.3L V8 YORTEC SFI , 0600507 | 03:03a |~

Figure 5-12 Sample Data Selection screen

2. Select or deselect the desired parameters.

3. Select DISPLAY DATA or press N/X to confirm your selections and return to the Codes
and Data display to view the customized data list.

Print Data
Selecting Print Data from the Exit menu gives two choices for printing data:

¢ Print Screen—sends any 4-line display of data or codes to a printer.

e Print Frame—prints one complete frame, or data transmission cycle, from the control
module, including any codes present if the data list contains codes.

How data prints depends on if the data is held.

e [f a frame was held when you exited from the data viewing mode, a print command wiill
print the exact data values that were displayed before exiting.

e [f a frame was not held before exiting, the scan tool continues to receive data
transmissions from the control module in the background and updates accordingly. A print
command prints the most current readings received by the scan tool—the data values or
trouble codes may have changed since you viewed the lines.

If the printer does not respond or fails during printing, an error message displays
(Figure 5-13).

Figure 5-13 Unable to Initialize Printer message

NOTE:
A movie printout may include the vehicle identification, but a movie display does not.
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B To print data:
1.

Make sure that the print options are set correctly. Refer to “Setting Up to Print” on page 18
for details.

2. Select either Print Screen or Print Frame.
This starts the printing operation (Figure 5-14).

Initializing printer ...

Figure 5-14 Initializing Printer message

When printing is complete, the scan tool automatically returns to the Exit menu.

Movies

When Movies appears on an Exit menu, it works the same as from a system Main Menu. See
“Movies” on page 48 for instructions for recording and reviewing a movie.

LED Menu

The LED Menu selection is used to program the operation of LEDs on the scan tool to monitor
certain digital data parameters. If a vehicle does not provide signals for these functions, the
respective LEDs are unused.

The LED assignments remain as selected until:

e You exit the data list.

e Test functions are changed on a vehicle that has a limited data stream in a particular
operating mode. For example, if a vehicle has a limited data stream for any functional test,
but not in the data viewing mode, custom LED settings return to their preset assignments
when you change test modes.

Selecting LED Menu from the Exit menu displays a screen similar to Figure 5-15.

P alel

GM 1980-2006
To Change LED Assignment, Scroll Choice
And Press Y To Select. Press N To Exit.
»L1=Not Used L3=Not Used

LZ2=Not Used L4=Not Used

2001 CHEVROLET TAHOE 4WD 5.3L V8 YORTEC SFI , 0610507 | 03:15a | <~

Figure 5-15 Sample LED Menu

B To change LED assignments:
1. Select LED Menu.
2. Press YIv to select an LED.
The cursor indicates the LED selected (Figure 5-15).
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3. Pressthe up A or down ¥ arrows to change the setting.
4. Press N/X to save your selections and exit the LED menu.

Fix Line and Release Line

Data line fix and release functionality, when available, depends on the vehicle year and
manufacturer.

Typically, when the data list is exited, the fixed lines are released automatically.

General Rules:

The lines referred to in these general rules refer to the data list lines and do not include the
software title line.

e | fom] |
1 [ >GCM  1980-2006
2 RPM 948 TPS(%) 37 TPS(V)  1.37
3 ST TRM AVGl $% 0 LT TRM AVGL % 9
4 02 B1-S1 (m¥) 812 02 B2-51(mV) 742
5 02 B1-S52 (mV) 738 02 B2-S2 (mV) 690
2001 CHEVROLET TAHOE 4WD 5.3L V8 YORTEC SFI , 0610507 | 03:18a | A

Figure 5-16 Sample data list screen

1— Software title

2— Data list line 1
3— Data list line 2
4— Data list line 3
5— Data list line 4

US Domestic and Asian Import general rules:

e Line 1is permanently fixed and cannot be released.
e Only lines 2 and 3 can be fixed; line 4 always scrolls.
e The title line cannot be fixed. Only data lines can be fixed.

e Line 2 must be fixed before line 3 can be fixed. Line 3 must be released before line 2 can
be released.

NOTE:
European vehicles generally allow the fix and release of data list lines 1 and 2.




B To fix and release lines of data:

Using the Scanner Functions

1. Scroll the desired data onto line 2 (Figure 5-17).

B8 |

02 B1-3S2 (mV) 786

INJ PW B1(mS) 13.9

02 B2-52 (mV)
INJ PW B2(mS) 14.0

2001 CHEVROLET TAHOE 4WD 5.3L V8 YORTEC SFI

106105007 | 03:20a, A

Figure 5-17 Data scrolled into position on line 2

2. Press N/X to open the Exit menu (Figure 5-18).

Custom Data List
Print Data
Movies

B | ==
GM 1980-2006
Resume LED Menu

»Fix Line 2

Press N to Exit

2001 CHEVROLET TAHOE 4WD 5.3L V8 YORTEC SFI

06105007 | 03:21a, A

Figure 5-18 Sample Exit Menu with no data lines fixed

3. Select Fix Line 2 to return to the Exit menu displays (Figure 5-19).
4. Press N/X again to open the Exit menu (Figure 5-19).

Print Data
Movies

e | o] =
GM 1980-2006
Resume _LED Menu__ _ _ _
Custom Data List L%BE%?E%?_E}E?_EJ

Fix Line 3
Press N to Exit

2001 CHEVROLET TAHOE 4WD 5.3L V8 YORTEC SFI

06105007 | 03:22a, A

Figure 5-19 Sample Exit Menu with line 2 fixed

5. Select either Release Line 2 or Fix Line 3.

5.6.2 Codes Menu

Selecting Codes Menu from the system main menu opens a list of data parameter viewing

options (Figure 5-20).
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e | fom] |
GM 1980-2006
GM Codes Menu
»Trouble Codes
Clear Codes
Freeze Frame/Failure Records [v]
2001 CHEVROLET TAHOE 4WD 5.3L W8 YORTEC SHI , 06/0507 | 10:20p | A

Figure 5-20 Sample Codes Menu list

Codes Menu selections typically include:

e Trouble Codes

e (Clear Codes

e Freeze Frame/Failure Records
e DTC Status

Trouble Codes

Trouble Codes displays a list of diagnostic trouble codes (DTCs) stored in the selected
electronic control module (ECM). Selecting opens a submenu of DTC viewing options on
some models. Submenu options allow you to view more detailed DTC information
(Figure 5-21).

B8 |

o=l

GM 1980-2006
Codes Menu GM Engine
»Engine/Trans Trouble Code Information
History Codes
Failed This Ignition [v]

2001 CHEVROLET TAHOE 4WD 5.3L V8 YORTEC SFI , 0600507 | 03:38a | A

Figure 5-21 Sample Trouble Codes submenu

Clear Codes

The scan tool clears trouble codes from the control module memory on some vehicles. If this
function is not available on the test vehicle, Clear Codes does not appear as a menu option.

Freeze Frame/Failure Records

This selection displays the DTC that was set, along with corresponding data, when the ECM
commanded the malfunction indicator lamp (MIL) to turn on.

DTC Status

This selection allows you to see if a particular DTC caused the MIL to turn on.



B To check DTC status

1.

© ©® N oA WD

Select DTC Status from the Codes Menu.

Using the Scanner Functions

The DTC Status screen displays with the cursor at the second character of the code

(Figure 5-21).

B8 |

o=l

GM 1980-2006
DTC Status
Scroll In Desired Trouble Code To

#%% POOO0O #++%

Test

2001 CHEVROLET TAHOE 4WD 5.3L V8 YORTEC SFI , 0600507 | 10:19p | S~

Figure 5-22 Sample DTC Status entry screen

Use the up A and down ¥ arrows to enter the second character.

Press Y/v' and the cursor moves to the third character.

Use the up A and down V¥ arrows to enter the third character.

Press Y/v' and the cursor moves to the fourth character.

Use the up A and down ¥ arrows to enter the fourth character.

Press Y/v and the cursor moves to the fifth character.
Use the up A and down ¥ arrows to enter the fifth character.
Press Y/v' and the status of the selected DTC displays (Figu

re 5-23).

B8 |

o=l

GM 1980-2006

P0106 MAP or BARO Pressure Circuit Out o

This Ignition Cycle Ran & Passed
Last Test Passed Since Clear Passed
History No MIL or SVS REQ No

2001 CHEVROLET TAHOE 4WD 5.3L V8 YORTEC SFI , 0600507 | 04:08a |~

Figure 5-23 Sample DTC Status screen

10. Press N/X to return to the DTC status entry screen.

1.

Press N/X again to return to the Codes Menu.

5.6.3 Functional Tests

The Functional Tests selection on the system Main Menu is used to access vehicle-specific
subsystem and component tests. Available tests vary by manufacturer, year, and model, and
only the available tests display in the menu.

There are four general types of functional test operations:

Information Tests—are read-only tests, like selecting “VIN”
menu to display the VIN of the identified vehicle.

from a Functional Tests
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¢ Toggle Tests—switch a component, such as a solenoid, relay, or switch, between two

operating states. The terms “on/off,” “open/clsd” (open/closed),” “enab/disa” (enable/

disable), and others may be used to identify the different states.

e Variable Control Tests—command a certain value for a system or component, such as
varying the spark timing in 1° increments or varying the EGR valve duty cycle in 10%
increments.

o Reset Tests—reset the adaptive, or learned, values that are stored in the control module.

5.6.4 Generic Functions

The Generic Functions selection opens a menu of available OBD-Il functions on 1996 and
newer vehicles. Menu options typically include:

® Freeze Frame—displays data stored in ECM memory when a DTC is set

¢ Readiness Monitors—displays the status of the OBD-I| required monitors

e Mode 6 Non Cont—displays the status of non-continuous OBD-Il monitors

e Mode 9 Calib. ID—displays the calibration identification numbers of the vehicle ECMs
e Mode 9 (CVN)—displays the calibration verification numbers of the vehicle ECM

¢ Mode 9 (VIN)—displays the vehicle identification number

5.6.5 Movies

The Movies feature lets you record and review captured data stream information.
Subsequent movie recording, entering a new vehicle ID, or disconnecting unit power erases
any previous movie. The length of a movie varies by make and model, and the amount of data
included in the movie varies according to the baud rate of the control module.

A recorded data movie includes:

e A number of data frames before the trigger
e The trigger point, which is frame zero (0)
e A number of frames after the trigger

Recording a Scanner Movie

Recording takes from a few seconds to several minutes, depending on the baud rate of the
vehicle control module.

The first step in recording a movie is to arm the Y/v' button as a trigger to begin recording.
Depending on the vehicle, you can arm the Y/v' button from the Scanner Main menu or the
Exit menu. Arming the movie works similar from either location.

B To arm the movie:
1. Select Movies from the menu
The Movie Menu displays (Figure 5-24).
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B8 |

ole

GM 1980-2006 l
* Movie Menu *

»ARM Movie
Print & Review Movie

2001 CHEVROLET TAHOE 4WD 5.3L V8 YORTEC SFI , 0600507 | 04:36a | A

Figure 5-24 Sample Movie Menu screen

2. Select Arm Movie.
The Data Main Menu may display (Figure 5-25).

B8 |

ole

GM 1980-2006 l
Data Menu SENSOR DATA
»ENGINE DATA 1
MISFIRE DATA

EGR, EVAP, ACC

2001 CHEVROLET TAHOE 4WD 5.3L V8 YORTEC SFI , 0610507 | 04:37a | A

Figure 5-25 Sample data selection menu

3. Select the data type, if necessary, and an instructional message displays (Figure 5-26).

B8 |

ole

GM 1980-2006 l
To clear movie memory and ARM trigger,
select continue. Frame Numbers will
appear on data screen after movie is
triggered. Press Y: Continue

| 2001 CHEVROLET TAHOE 4WD 5.3L V8 YORTEC SFI , 0610507 | 04:37a | A

Figure 5-26 Sample On-screen instructions to arm movie trigger

4. Press YIv to erase any movie stored in memory and return to the data display.
“ARM” appears on the left of the screen to indicate that the movie is armed (Figure 5-27).

B8 |

ole

GM 1980-2006

ARMJRPM 1977 TPS (%) 99 TPS (V) 4.22
02 B1l-S1 (mV) 911 02 B2-S51(mV) 885
02 B1-3S2 (mV) 946 02 B2-52 (mV) 942

INJ PW B1(mS) 16.0 INJ PW B2(mS) 15.9

| 2001 CHEVROLET TAHOE 4WD 5.3L V8 YORTEC SFI , 0610507 | 04:38a |~

Figure 5-27 Sample Data display, armed to record a movie

E] To abort the ARM Movie selection:
e Press N/X. Previously recorded movies are preserved, and the Exit menu displays.
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B To record a movie:
e After arming, press Y/v to trigger the recording of a movie at any time.

The movie starts and “ARM” changes to three zeros (000) on the display (Figure 5-28).

G =
GM 1980-2006
003)RPM 1378 TPS (%) 0 TPS(V) _ 0.00
02 B1-51 (mV) 781 02 B2-51(mV) 200
02 B1-52 (mV) 786 02 B2-52 (mV) 781
INJ PW B1(mS) 13.1 1INJ PW B2(mS) 14.0
2001 CHEVROLET TAHOE 4WD 5.3L V8 VORTEC SFI , 06/0507 | 04444 | A

Figure 5-28 Sample Data display after triggering a movie

The frame counter in the upper left advances to show the recording speed of the movie.
Once the maximum number of frames are recorded, “END” displays (Figure 5-29).

] =
GM 1980-2006

End)RPM 1907 TPS(%) 94 TPS (V) 3.39

02 B1-S1 (mV) 894 (02 B2-51(mV) 890

02 B1-82 (mV) 928 (02 B2-52 (mV) 929

INJ PW B1(mS) 15.9 INJ PW B2(mS) 15.7

2001 CHEVROLET TAHOE 4WD 5.3L V8 YORTEC SFI , 0600507 | 04:45a | A

Figure 5-29 When the movie is finished recording

“END” remains in the top line, even when reviewing live data, to remind you that a movie
has been recorded.

Reviewing a Movie

When reviewing a movie, the following general rules apply:

You always enter the movie at frame 0, the trigger point. The up A and down ¥ arrows
scroll data lines within that frame. The frame number displays in the upper left corner.

Press Y/v' and the Thumb Pad operation switches to scroll frames. In this mode, the
display moves forward or backward in time. The frame number in the upper left corner
changes with each Thumb Pad press. A positive number indicates a frame after the
trigger; a negative number indicates a frame before the trigger.

Press Y/v to switch the Thumb Pad function between scrolling frames to scrolling data
lines within a frame.

Scroll from frame to frame and data lines on the screen stay in the same position.
Parameter names do not change, but readings may because different values were
recorded from frame to frame.

As you scroll data lines within a frame, the Thumb Pad moves the lines from top to bottom
within that frame. It does not roll over into an earlier or later frame.

Codes may change from frame to frame as recorded. The mode title does not change.
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e Lines may be fixed using the Fix Line options on the Exit menu. Fixed lines remain fixed
during horizontal and vertical scrolling until released through the Exit menu.

e When you resume reviewing a movie, Thumb Pad scrolling operation stays in the
condition last selected by pressing Y/v' before exiting.

e Press N/X to exit at any time.

E] To review a recorded movie:
1. From the data display, press N/X. to open the Movie Menu (Figure 5-30).

P =

GM 1980-2006 l
* Movie Menu *

ARM Movie
»Print & Review Movie

2001 CHEVROLET TAHOE 4WD 5.3L V8 YORTEC SFI , 0600507 | 04:46a | S~

Figure 5-30 Sample Movie Menu screen

2. Select Print & Review Movie and the recorded movie displays (Figure 5-31)

G =
GM 1980-2006
000 RPM 1378 TPS (%) 0 TPS(V) _ 0.00
02 B1-51(mV) 781 02 B2-51(mV) 200
02 B1-52 (mV) 786 02 B2-52 (mV) 781
INJ PW B1(mS) 13.1 1INJ PW B2(mS) 14.0
2001 CHEVROLET TAHOE 4WD 5.3L V8 VORTEC SFI , 06/0507 | 04444 | A

Figure 5-31 Sample Recorded data movie screen

3. Press Y/V to start the movie and use the Thumb Pad to navigate through the data.

5.6.6 Troubleshooter

The Troubleshooter selection appears on the system Main Menu only if Fast-Track®
Troubleshooter information is available. Fast-Track® Troubleshooter is a database of
experience-based information of validated real-world repair strategies that top-notch
technicians have compiled since 1988.

Select Troubleshooter, and a system menu may display (Figure 5-32).
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o=l

r
»ENGINE

TRANSMISSTION

2001 CHEVROLET TAHOE 4WD 5.3L V8 VORTEC SFI , 0600707 | 09:07p |~

Figure 5-32 SampleTroubleshooter system menu

Select a system and a Troubleshooter Menu similar to Figure 5-33 displays.

r

» INTRODUCTION; READ FIRST l
* CODE SET CONDITIONS

* CODE TIPS

* SYMPTOM TIPS

2001 CHEVROLET TAHOE 4WD 5.3L V8 YORTEC SFI , 0610507 | 04:51a | <~

Figure 5-33 Sample Troubleshooter Menu

Troubleshooter menus vary by make, model, and system. Refer to the Fast-Track®
Troubleshooter Quick Reference Guide for information.

5.6.7 Custom Setup

The Custom Setup selection is used to change the units of measurement. Choose between
US customary or metric units of measure for available data parameters.

Table 5-1 Units of measurement—defaults and options

SETTING DEFAULT OPTION
Temperature degrees Celsius (°C) degrees Fahrenheit (°F)
Air Pressure (including . . “
manlfold pressure) kilopascal (kPa) inches of mercury (“Hg)
Speed kilometers per hour (kph) miles per hour (mph)
Other Pressures kilopascals (kPa) pounds per square inch (psi)

E] To change a setting:
1. Select Custom Setup to open the units of measurement menu.

The current settings are shown in brackets (Figure 5-34).
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B8 |

o=l

GM 1980-2006 l
Select Parameter To Change:
Press Y to Change Units. N to Exit.
»Temperature [C] Alr Pressure [kPa]
Veh Speed [KPH] Other Press [kPa]

2001 CHEVROLET TAHOE 4WD 5.3L V8 YORTEC SFI , 0610507 | 04:51a | <~

Figure 5-34 Sample English/Metric Menu

2. Highlight a measurement and press Y/v' to switch between settings.
3. Press N/X to confirm your selection and return to the Main menu.

5.6.8 Demonstration Programs

The scan tool contains a program to demonstrate many of the scan tool test capabilities
without actually connecting to a vehicle (Figure 5-35). A sample vehicle ID and mock test
results are provided to help you become familiar with menus, navigation, and basic
operations. Refer to “Demonstration Mode” on page 19 for details.

B8 |

GM 1980-2006
Select:

06105007 | 04:56a, A

Figure 5-35 Sample Demonstration option

NOTE:

If Fast Track® Troubleshooter software is available for the selected vehicle, it will be
accessible for demonstration.

5.6.9 Terminating Vehicle Communication

Once you have established communication with a vehicle, you must terminate communication

with the vehicle control module in order to safely shut down the scan tool. Use the following
procedures to terminate correctly.
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B To terminate communication:
1. Press N/X until you reach the software confirmation screen (Figure 5-36).

B | =T
GM 1980-2006
»GM Database (1980-2006) vV 11.0

Press Y: Continue

1 — 2 3 4

06105007 | 04572, A

Figure 5-36 Sample Software Confirmation screen

2. Press «to highlight the View button on the upper toolbar.
3. Press NIX to return to the scan tool Main Menu.

IMPORTANT:

For some vehicles, a “Stop Communication” or “End of Diagnose” selection appears on the
Vehicle Main Menu (Figure 5-37). When available, making this selection safely terminates the
connection between the scan tool and the vehicle control module.

o=l

B8 |
Global OBDII

Main Menu OBD
Connector Information
Custom Setup

»End of Diagnose

1 — 2 3 4

706105007 | 04:56a, A

Figure 5-37 Sample End of Diagnose selection

5.6.10 Exiting Scanner Mode

Always exit Scanner mode before powering off. Exiting Scanner mode is different depending
on the view option selected.

IMPORTANT:

Exiting Scanner mode does not ensure that you have safely terminated communication with
a vehicle. See “Terminating Vehicle Communication” on page 53. Also see “Scanner Button”
on page 22.

B To exit Scanner mode from text screens:
1. Use right » and left € arrows to scroll the highlight off of the Scanner button.
2. Press N/X to return to the main menu.

B To exit Scanner mode from PID List or Graphs views:
e Press N/X until you return to the main menu.
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5.7 Viewing Data Graphically

The scan tool provides multiple options for viewing and sorting collected data.

,%“W—« S | o) =)

=i Ll

I|  Text GM 1980-2006

|| JoemipM 1378 TPS (%) 0 TPS(V)  0.00

| temnll-S1(mv) 781 02 B2-S1(mv) 200
©Z B1-52 (mV) 786 02 B2-32 (mV) 781
INJ PW B1(mS) 13.1 INJ PW B2(mS) 14.0
L 1 2 3 4 ) |

I 2001 CHEVROLET TAHOE 4WD 5.3L V8 YORTEC SFI , 0610507 | 05:11a | <~

Figure 5-38 Sample VIEW menu

5.7.1 Changing Screen Views
Data can be viewed in the following formats:

e PID List view
e Text view
e Graph view

B To change screen views:
1. Select the VIEW button.
A drop-down menu displays (Figure 5-38).
2. Select an option from the menu.
The screen layout changes to the selected format.

PID List View

The PID (parameter identification) List view displays all parameters in a table format. As many
as eight parameters (Figure 5-39) can be viewed on one screen depending on the ZOOM
setting (see “Using ZOOM” on page 64 for more information).

EP | R | 2=l
RPM 2883 ﬂ
TPS(%) 91
TPS{V) 3.27
02 B1-S1(mV) 903
02 B2-S1(mV) 894
02 B1-S2(mV) 937
02 B2-S2(mV) 946
INJ PW B1(mS) 16.1 B

| 2001 CHEVROLET TAHOE 4WD 5.3L W8 YORTEC SHI , 06/0507 | 05:11a |~

Figure 5-39 Sample PID List view
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Reviewing PIDs

You can review collected PID data by pausing the screen (Figure 5-40). Up to 512 frames of
data can be reviewed.

1 2 /3
S A —

RPM 1984 ﬂ

TPS(%) 93

TPS{V) 0.04

02 B1-S1(mV) 903

02 B2-S1(mV) 898

02 B1-S2(mV) 950

02 B2-S2(mV) 937

INJ PW B1(mS) 15.2 B
2001 CHEVROLET TAHOE 4WD 5.3L W8 YORTEC SFI , 06/0507 | 05:11a | ~p

Figure 5-40 Sample paused upper toolbar in PID View

1— Pause/Play button
2— Data Review control
3— PID data

IE To review collected PID data:
1. Select the Pause button to stop the data collection.

2. Select the Data Review control and use the right » and left € arrows to scroll through the
stored data one frame at a time.

3. Press N/X to release the Data Review control.
4. Select the Play button to unlock the screen.

Locking PIDs

You can lock PIDs in place for customized list viewing.

E] To lock a PID:

1. From the upper toolbar, press the down ¥ arrow.
2. Select the PID you want to lock.
The parameter menu displays (Figure 5-41).

[ Q| oiEl

1896
| Lo | 478
= MNT Ty 93 LI
INTAKE AIR(°C) 48
START CLNT(°C) 91
IAC POSITION 196
DES IAC gisec 27 83
VTD FUEL OFF -
2001 CHEVROLET TAHOE WD 5.3L W8 WORTEC SFI , 06/0507 | 05:13a |~

Figure 5-41 Sample parameter menu

3. Select Lock.
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A lock icon displays to the left of the parameter name (Figure 5-42) and the locked PID

stays in place when your scroll through the PID list.

E ] L | =T
RPM 1968 =
59 =
TPS(V) 425
02 B1-51(mV) 507
02 BZS1(mV) 594
02 B1-52(mV) 537
02 B2-52(mV) 550
INJ PW BA(mS) 161 I
2001 CHEVROLET TAHOE WD 5.3L W8 WORTEC SFI , D6/0507 | 05:17a |~

Figure 5-42 Locked PID sample

4. Repeat the above steps to lock multiple PIDs.
5. Press N/X to return to the upper toolbar.

E] To unlock PIDs:

1. Select a locked PID and when the parameter menu displays, select Unlock.
The lock icon disappears and the parameter can be scrolled as before.

2. Press N/X to return to the upper toolbar.

IE To unlock all the PIDs at once, do one of the following:

e Select a locked PID and when the parameter menu displays, select Unlock All.

e Select any option from the ZOOM menu.

Text View

Text view displays parameters as plain text (Figure 5-43).

| G vew D scanmies | fom] |

[ PID List |

GM 1980-2006
JoumRPM 3238 TPS(8) 0 TPS(V)  0.00
4 Graph L =S 1 (V) 65 02 B2-51 (mV) 74
02 B1-S2 (mV) 647 02 B2-52 (mV) 677
INJ PW Bl(mS)714.2 INJ PW B2 (mS)ilﬂl.l

L 1 — 2 3

4

| 2001 CHEVROLET TAHOE 4WD 5.3L V8 YORTEC SFI

706105007 | 05:18a, A

Figure 5-43 Sample Text view

Graph View

The Graph view let you view data in line graph format (Figure 5-44). You can view one, two,
or four graphs at a time depending on the option selected from the VIEW menu.
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3. ...l o = [
02 B1-51(mv) =
1 ———- 911
2 ———- 208
3 —— 52|, | | | | L | 1 | L 1
450 400 350 300 250 200 150 100 50 [
2001 CHEVROLET TAHOE WD 5.3L V8 YORTEC SFI L D6/0507 | 05:218, Az

Figure 5-44 Sample 1 Graph screen

1— Maximum value of captured data
2— Current value
3— Minimum value of captured data

Parameter Menu

When viewing data in the Graph view, the scan tool offers a parameter menu (Figure 5-45)
with the following options:

Lock—Iets you lock a parameter into position to compare readings.
Unlock—Ilets you unlock a single parameter.
Unlock All—lets you unlock all locked parameters.

Scale—lets you rescale the minimum and maximum graph values captured within the last
2000 points.

Set Trigger Levels—Ilets you specify automatic screen-freezing conditions when
SNAPSHOT > PID Trigger is used.

Clear Trigger Levels—lets you remove set trigger conditions from the selected
parameter.

Clear All Trigger Levels—lets you remove set trigger conditions from all parameters
simultaneously.

B To lock a parameter:

1.

3.

58

From the upper toolbar, press the down ¥ arrow.
The highlight moves to the first parameter graph.
Select the parameter you want to lock.

The parameter menu displays (Figure 5-45).

R [T — | Dlal=
02 B1-52(m¥) =
"“W L

369[ | | | | |

INJ PW B1(mS)

16_Z2|

13_8|

1 5.0 | 1

260 150 160 SID b
I 2001 CHEVROLET TAHOE 4WD 5.3L V8 YORTEC SFI , 0600507 | 05:22a | S~

| | | L
200 150 100 50

Figure 5-45 Sample parameter menu

Select Lock.
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A lock icon displays (Figure 5-44). The locked graph will not move when you scroll
through the remaining graphs.

@%waw | il QZDDM 122 I SNAPEHDTI élﬁl

-

911 =

803

5zl I 1 I 1 I I I 1

02 B2-S1(mv)
903

815

39 I | | | I | 1 | I 1
450 400 350 300 250 200 150 100 50 b

|| 2001 CHEVROLET TAHOE 4WD 5.3L V8 YORTEC SFI , 0610507 | 05:23a | A

Figure 5-46 Lock icon indicating a locked parameter

4. Scroll other parameters into place to compare readings.

B To unlock a parameter:
1. Select the locked parameter.
The parameter menu displays (Figure 5-47).
2. Select Unlock.
The lock icon disappears and the parameter can be scrolled as before.

| D] R TSN = =Y P

Unlo
Tinlock-Al1
Scale

Set Trigger Lewels | | | | | | | | | |
Clear Trigger Levels
Clear All Trigger Lewels

894 | |” 1"'

EETN

4%0 460 3.‘50 360 ZED 260 léﬂ 160 EID ht
I 2001 CHEVROLET TAHOE 9WD_5.3L V8 VORTEC SFI | 06105107 | 05:232 | A

Figure 5-47 Sample parameter menu

E] To unlock all parameters:
1. When a PID is locked on-screen, select any parameter.
The parameter menu displays (Figure 5-48).

B D] S R PO =T =Y P

Tinlock
Unlo
Scale
Set Trigger Lewels | | | | | | |
Clear Trigger Levels
Clear All Trigger Lewels

890 I" |”1

EETA

| | | | 1 L 1
450 400 350 300 250 200 150 100 50 b

I 2001 CHEVROLET TAHOE 4WD 5.3L V8 YORTEC SFI , 0600507 | 05:24a | S~

Figure 5-48 Sample parameter menu

2. Select Unlock All.
All of the lock icons disappear and all of the locked parameters can now be scrolled.
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B To scale a parameter:
1. Select a parameter.
The parameter menu displays (Figure 5-49).

| D] S O [ WO = J=Y P

Lock
Tnlock-All

Set Trigger Lewels | | | | | 1 1 | | |
Clear Trigger Levels
Clear All Trigger Lewels

T

39l

4%0 460 3.‘50 360 ZED 260 léﬂ 160 EID ht
[ 2001 CHEVROLET TAHOE 9WD 5.3L V8 VORTEC SFI | 060507 | 05:290 | A

Figure 5-49 Sample parameter menu

2. Select Scale.
The minimum and maximum graph values are reset.

E] To set trigger levels:
1. Select a parameter.

The parameter menu displays (Figure 5-50).

| D] O (o] IS

Lock
TUnlock-All
Scale

Clear Trigger Levels
Clear AIl Trigger Levels

and[ T T

39} |

4%0 460 3.‘50 360 ZED 260 léﬂ 160 EID ht
[ 2001 CHEVROLET TAHOE 9WD 5.3L V8 VORTEC SFI | 060507 | 05:292 | A

Figure 5-50 Sample parameter menu

2. Select Set Trigger Levels.

The active trigger level line displays as a solid black line together with an on-screen
position value (Figure 5-51).

B D] S R PO I =Y P

S W T
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02 B2-S1(mv)
903

w
W

815

391 | | | | 1 | I | L 1
450 400 350 300 250 200 150 100 50 b

I 2001 CHEVROLET TAHOE 4WD 5.3L V8 YORTEC SFI , 0600507 | 05:25a | A

Figure 5-51 Sample active trigger line

NOTE:
m Both an upper and lower trigger level must be set.
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3. Adjust the upper trigger level using the up A and down ¥ arrows to place the trigger level
line where you want it on the PID graph.
4. Press YIV to set the trigger.
When set, the solid black line changes to a dotted line and the position value no longer
displays (Figure 5-52).
55..... ]
02 B1-S1(m\)
1 >
2—p—»! -
20[!14(25:EVR0‘II_TEDT TAH;ZDAlWD 35?;LV8\?;ID1TEC SzFDID — Jl E(DiJUSJ[I?EJD Uﬁ:ZSa;{-‘;?
Figure 5-52 Sample set trigger levels
1— Upper trigger level
2— Lower trigger level
5. Adjust the lower trigger level using the up A and down V¥ arrows and press Y/v' to set it.
The area between the two trigger levels establishes the triggering condition. Any data
points that register outside of your set condition trigger the on-screen graphing to pause.
6. Press Y/v if you want to switch between trigger level lines during the setting process.
7. When you finish setting your trigger level, press N/X.
NOTE:

Only three PIDs can have trigger levels set at one time, but only one of the conditions needs
to be satisfied for triggering to occur.

To arm PID Triggering:
¢ From the upper toolbar, select SNAPSHOT > PID Trigger.

A check mark displays next to the menu option (Figure 5-53).

N B IS
-

Figure 5-53 Sample armed triggering

Trigger Delay

Once the trigger is detected, a collecting snapshot dialog box displays (Figure 5-54) and data
after the trigger detection begins to collect.

Collecting snapshot.
Please wait...

Press "Y' to stop
collecting data now.

Figure 5-54 Sample collecting snapshot dialog box
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The amount of data collected is specified by the % After Trigger setting, found in UTILITIES
> Tool Setup > Save Data. You can manually stop the snapshot by pressing Y/v" at any time
during the data collection.

Once data collection is finished, graphing on-screen stops and the Pause button automatically
changes to the Play button (Figure 5-55).

s | SO (o] DIEIE]

Figure 5-55 Sample “frozen” upper toolbar—Play button

At the triggering point, a green line displays on all PID graphs (Figure 5-56).
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Figure 5-56 sample trigger detection line

IE To restart graphing:
e Select the Play button (Figure 5-55).

IE To clear trigger levels:
1. Select a parameter.

The parameter menu displays (Figure 5-57).
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Figure 5-57 Sample parameter menu

2. Select a Clear option.
— Clear Trigger Levels—removes the trigger settings from the one selected PID only.

— Clear All Trigger Levels—removes the trigger settings from all of the PIDs with
trigger settings.

|E| To disarm PID Triggering:
e Select SNAPSHOT > PID Trigger.
The check mark next to the menu option disappears (Figure 5-58).



Viewing Data Graphically

N [P IS
-

Figure 5-58 Sample armed triggering

5.7.2 Pausing Data

The Pause button temporarily stops, or “pauses”, data collection when viewing parameter
data in the PID List or Graphs views (Figure 5-59).

[ | =T |

Figure 5-59 Pause button viewing “live-screen” data

When the Pause button is selected, it changes to the Play button (Figure 5-60), which
resumes data collection.

> | ==

Figure 5-60 Play button—viewing “frozen-screen” data

5.7.3 Using Cursors

When data is frozen on-screen in Graph view, the Cursor button displays on the upper toolbar
(Figure 5-61), which allows you to view digital amplitude measurements of frozen data.

] B [oon] ClEE

Figure 5-61 Sample frozen screen with Cursors active

B To use the Cursor:
1. Select the Pause button.
2. Select the Cursor button.

Cursors lines display on the frozen data (Figure 5-62). The value where the cursor line
intersects the frozen data displays above the cursor line.
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Figure 5-62 Sample cursors on frozen data

3. Press the left € and right » arrows to move the cursor.
4. Press N/X to exit the Cursor mode.

5.7.4 Using ZOOM

The ZOOM button lets you choose the number of PIDs that display on-screen when used in
the PID List view (Figure 5-63) and lets you choose different levels of magnification when
used in the Graph view (Figure 5-64).
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Figure 5-63 Sample PID List ZOOM options
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Figure 5-64 Sample Graph ZOOM options

5.7.5 Resetting Min/Max Data Values

When viewing data in graph mode, the minimum and maximum (Min/Max) values displayed
on each graph represent the highest and lowest values the scan tool has displayed. These
values can be recalculated during testing if necessary.

E] To reset Min/Max values:
1. Select the Tools button on the upper toolbar.
A Min/Max Values window displays (Figure 5-65).

[RPM

Min/Max Values

Figure 5-65 Min/Max values reset



2. Press Y/v to reset the values.

Saving Captured Data

The values reset to reflect the data that is visible on the screen.

5.8 Saving Captured Data

There are multiple options for saving and reviewing captured data:

¢ Movies—The Movie feature allows you to save up to 2000 frames of buffered data for
each available PID. Movie files can be saved from the Text, PID, and Graph views, but

can only be replayed in the Graph view.

e Screen files—The Screen file feature allows you to save up to 512 frames of buffered

data for each PID. Screen files can be saved from the Text, PID, and Graph views, but can

only be replayed in the Graph view.

e Bitmap files—The Bitmap file feature allows you to capture a single screen.

E] To save a Movie file:

1. Select the Save button from the upper toolbar.
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Figure 5-66 Save Button

2. Select the Save All Pages menu item.
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Figure 5-67 Save Movie File Menu Selection

The Saving Scanner data....message will display.

E] To review a Movie file:

1. Select the Saved Data button from the main menu.
2. Select the Data Management menu option (Figure 5-68).

A list of all saved files displays.
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™~ I SO LUSPRrRO"

Data Management
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Figure 5-68 Data Management Menu Option

3. Highlight the movie file that you would like to review.
4. Select LOAD on the toolbar to open the file (Figure 5-69).
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Figure 5-69 Load DataScreen

NOTE:
Movie files are saved with a SC(M) extension and only display in Graph view.

5. Select the REVIEW button to set the data viewing speed.

To save a Screen file:

1. Select the SAVE button from the SCANNER tool bar.
2. Select the Save Page menu item.

3. The Saving Scanner data....message displays.

To review a Screen file:
1. Select the Saved Data button from the main menu.

2. Select the Data Management option.

3. Alist of all saved files displays.

4. Select the screen file that you would like to review.
NOTE:

Screen files are saved with a SC(S) extension.

To save a Bitmap screen shot:
1. Select the SAVE button from the upper tool bar.
2. Select the Save Bitmap menu item.
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Figure 5-70 Save Bitmap Menu Option

B To review a Bitmap screen shot:

1. Select the Saved Data button from the main menu.
2. Select the Data Management option.

3. Alist of all saved files displays.

4. Select the Bitmap that you would like to review.

Viewing Saved Data

Use the Saved Data button to access the Data Management screen option (Figure 5-71).
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Figure 5-71 Sample Saved Data menu

The Data Management screen lets you manage your scan tool storage memory and your
saved files (Figure 5-72).
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Figure 5-72 Sample Data Management screen
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1— Saved data files
2— Saved data location indicators
Displays where the saved files are located; the CF card, internal memory, or a USB
mass storage device. A red “X” indicates there is no device installed in that port.
3— LOAD button
Opens the saved file selected.
4— EDIT button
This function is not available in the Scanner software.
5— DELETE button
Erases the saved file(s) from storage memory.
6— COPY button
Lets you copy the selected file(s) from one location to another.
7— MOVE button
Lets you move the selected file(s) from one location to another.
8— SELECT ALL button
Selects all files.
9— Memory indicator
Displays the amount of memory available.
10—SETUP button
Lets you set the location where files are saved.

5.9.1 Identifying Saved Files

Saved files have the following characteristics:

Type names the kind of saved data file:

- SCM—Movie data file of up to 2000 data points saved from the Save All Pages item
on the upper toolbar.

- SCS—Movie data file of up to 512 data points saved from the Save Page item on the
upper toolbar.

- SCP—Snapshot file of one datastream transmission saved from the Snapshot button
on the upper toolbar.

- BMP—Screenshot saved with the S button set to Save Bitmap. See “S Button” on
page 76 for details.

Size is the percentage of available storage space used.
Date/Time is the date and time that the data was saved.
Year is the vehicle model year.

Make is the vehicle manufacturer.

Component is the component tested.

Condition is for good, bad, or unknown status options.

E] To exit the Data Management screen:

Press N/X.



Viewing Saved Data

5.9.2 Loading Saved Files

The LOAD button lets you review saved screen data and print the screen.

IE To load data:
1.

Select Saved Data > Data Management.
The Data Management screen displays.
2. Select afile from the list.
3. Select LOAD from the upper toolbar.
The selected file displays.

IE To exit the loaded screen:
1. Press N/X to return to the Data Management screen.
2. Press N/X again to return to the main menu.

5.9.3 Reviewing Saved Data

The REVIEW button is used with the Thumb Pad to review movie data files.
There are two ways to review data files:

e Manually
e Automatically

IE To review data files manually:
1. Select the REVIEW button.
2. Use the right » and left € arrows to review data one frame at a time.

E] To automatically scroll data files:

1.  With the REVIEW button selected, press Y/v" again to display a drop-down menu of
options (Figure 5-73).
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Figure 5-73 Sample REVIEW drop-down menu

2. From the REVIEW menu, select an Auto option.
— Auto Scroll Fast automatically scrolls the data on-screen at full-speed.
— Auto Scroll Slow automatically scrolls the data on-screen at half-speed.
3. Press N/X to close the menu.
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5.9.4 Deleting Saved Files

The DELETE button lets you remove saved files from memory.

(3

NOTE:
Factory-installed files cannot be deleted.

To delete files:
Select Saved Data > Data Management.
2. Select afile from the list.
3. Select DELETE from the upper toolbar.

A confirmation message displays (Figure 5-74).
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Figure 5-74 Sample Delete file confirmation message

4. To permanently remove the data from memory, press Y/v/, or press N/X to keep the data
and close the dialog box.

After processing your delete request, you are returned to the Data Management screen.

5.9.5 Copying and Moving Saved Data

3

The COPY and MOVE functions let you transfer saved test data from one location to another.

To copy or move data:
From the main menu, select Saved Data > Data Management.
The Data Management screen displays.
From the upper toolbar, select SETUP.
The Save Data dialog box displays.

Set CF as the Save To option and press N/X to close the dialog box.
The test data saved to the CF card displays.
Use the up A and down V¥ arrows to highlight a file from the list on-screen.
Use right » and left € arrows to select COPY or MOVE from the upper toolbar.

1.

A confirmation message displays.

Press Y/v to close the message box.
You return to the Data Management screen.



Viewing Saved Data

NOTE:
Factory installed files can not be deleted, copied or moved.

5.9.6 Selecting All Files

Use SELECT ALL to highlight all files on-screen so you can delete, copy, or move the files as
needed (Figure 5-75).
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Figure 5-75 Sample SELECT ALL screen

5.9.7 Setting a Destination for Saved Data

Use SETUP to identify the destination for saved files (Figure 5-76). The default destination is
the CF card slot.

Movie Size % After Trigger My data

Min 30 Internal

Tt A—
CF
USE Disk

Figure 5-76 Sample Save Data dialog box

B To change the destination for saved files:
1. Select Saved Data > Data Management.
The Data Management screen displays.
2. Select the SETUP button.
The Save Data dialog box displays (Figure 5-76).
3. Select an option from the Save to drop-down menu.
4. Press N/X to confirm your selection and close the dialog box.
The checkbox for the location you selected is checked (Figure 5-77).

Sl [P
v \
D= VM3, [0xX
Type Size | Date/Time Year | Make
BMP g% 06/05/10 er(0

Figure 5-77 CF slot indicator checked
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5.10 Printing

The PRINT button lets you print the displayed screen. The following printing options may be
available:

¢ Full Screen—oprint only what is visible on the screen at the time of printing.
e Full PID List—oprints the entire list of PIDs in PID List view and Text view.

For related information, see the following sections:

e “Print Data” on page 42
e “S Button” on page 76

B To print:

1. Verify that your printer and scan tool are set up properly for printing. See “Setting Up to
Print” on page 18 for details.

2. Select PRINT > print option (Figure 5-78).

B8 | e |
| GM 1980-2006 Full PID List

Figure 5-78 Sample Print menu

When printing begins, an “Initializing printer...” message displays (Figure 5-79).

Initializing printer ...

Figure 5-79 Sample Initializing printer message

5.11 Utilities

The Utilities button provides access to system information and controls (Figure 5-80).
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Figure 5-80 Sample UTILITIES menu

The Utilities options available are discussed in the following sections:

e “Tool Setup” on page 73
e “System Tools” on page 78
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e “Easy Scroll” on page 78

e “Connect to PC” on page 79
e “Run...” on page 79

e “Shop Info” on page 79

e “System Info” on page 80

5.11.1 Tool Setup

The Tool Setup submenu (Figure 5-81) lets you adjust certain settings for optimum

performance.
™~ SOLUSPRO"

Tool Setup ] Power Management
Systern Tools » Save Data

Easy Scroll
Connect to PC
Run...
Shop Info
System Info

Printer

Date

Time

Time Zone

S Button
Color Theme
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Figure 5-81 Tool Setup sample menu

The Tool Setup submenu includes the following options:

e “Power Management” on page 73
e “Save Data” on page 74

e “Printer” on page 74

e “Date” on page 75

e “Time Zone” on page 76

e “Time” on page 75

e “S Button” on page 76

e “Color Theme” on page 77

Power Management
The Power Management option lets you select several backlight options.

e Timer—The backlight turns off at the set time.
e On—The backlight remains on at all times.
e Off—The backlight remains off at all times.

For related information, see “Powering Off the Unit” on page 19.
B To set power management options:

1. Select Utilities > Tool Setup > Power Management.
2. Select settings from the drop-down menus (Figure 5-82).
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Power Management

Backlight Timer Settings

[30 Seconds

Figure 5-82 Sample Power management dialog box

3. Press N/X to confirm your selection and close the Power Management dialog box.

Save Data

Selecting Save Data lets you adjust the size of each recorded movie and the amount of data
recorded after a trigger-point. Save Data also lets you set the saving and loading location for
all saved files.

E] To adjust snapshot preferences:
1. From the main menu, select Utilities > Tool Setup > Save Data (Figure 5-83).
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Figure 5-83 Sample Save Data dialog box

The Save Data dialog box displays.

2. Select from the drop-down lists as necessary.
The drop-down list closes automatically.

3. Press N/X to close the Save Data dialog box.

NOTE:
The Save Data dialog box can also be accessed from the Setup menu on the Saved Data
management screen.

Printer

Select Printer to configure the scan tool to your printer. Your scan tool supports printing to
Hewlett-Packard (HP) PCL 3 and Epson Stylus printers (color and black & white).

B To configure for your printer:
1. Select Utilities > Tool Setup > Printer.
The Printer dialog box displays (Figure 5-84).
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Manufacturer Port

HP PCL 3 Color USB

IRGIEIeTis e
HP PCL 3 Ba&W
Epson Stylus Color
Epson Stylus B&W

Figure 5-84 Sample Printer dialog box

2. Select from the menus as necessary.
3. Press N/X to close the Printer dialog box.

Date
Selecting Date lets you set the date that displays in the Saved Data properties.

IE To set the date:
1. Select Utilities > Tool Setup > Date.
The Date dialog box displays.
2. Press Y/v to open a drop-down list of display options (Figure 5-85).

Figure 5-85 Sample Date dialog box

3. Select an options from the drop-down list.
The drop-down list closes automatically.
4. Press N/X to close the Date dialog box.

Time

Selecting Time lets you set the time that displays in the Saved Data properties.

E] To set the time on the system:
1. Select Utilities > Tool Setup > Time.
The Time dialog box displays.
2. Select the Hour, Minutes, or 12/24 field.
A drop-down list displays (Figure 5-86).
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Figure 5-86 Sample Time dialog box

3. Select an option from the drop-down list.
The drop-down list closes automatically.
4. Press N/X to close the Time dialog box.

Time Zone

Selecting Time Zone lets you set the time zone for the internal clock, and to select between
standard or daylight savings time.

To set the time zone on the system:
1. Select Utilities > Tool Setup > Time Zone.
The Time Zone dialog box displays (Figure 5-86).

Time Zone DST
GMT08:00 (Pacific Time| Yes

Figure 5-87 Sample Time Zone dialog box

2. Select the Time Zone or DST field.
A drop-down list displays.
3. Select an option from the drop-down list.
The drop-down list closes automatically.
4. Press N/X to close the Time dialog box.

S Button

Selecting S Button allows you to change the functionality of the S button. Possible function
assignments include:

e Pause/Play—works as the Pause/Play button when viewing data in the Graphs or PID
List views. See “Pausing Data” on page 63 for details.

e Print List—works like the Full PID List selection from the PRINT button in the upper
toolbar. See “Printing” on page 72 for details.

e Save Page—works as the Save Page selection from the SAVE button in the upper
toolbar when this option is available. See “Saving Captured Data” on page 65 for details.

e Print Page—works like the Page or Full Screen selections from the PRINT button in the
upper toolbar. See “Printing” on page 72 for details.
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NOTE:
The S button can only perform print functions when the PRINT button is visible in the upper
toolbar.

e Save Bitmap—is the default and takes a bitmap (BMP) screen shot. This feature can
work anywhere in scan tool operations and the resulting bitmaps files can be opened
using standard Internet browsers or graphics applications.

IE To assign a function to the S button:
1. Select Utilities > Tool Setup > S Button.
The S Button dialog box displays
2. Press Y/v to open the drop-down list (Figure 5-88).

Function

Save Bitmap

Print List
Save Page
Print Page
Save Bitmap

Figure 5-88 Sample S Button dialog box

3. Select a function from the drop-down list.
4. Press N/X to close the dialog box.

Color Theme

Selecting Color Theme lets you change the appearance of background on the display. Using
the black background helps conserve battery power.

|E| To change the screen background:
1. Select Utilities > Tool Setup > Color Theme.
The Color Theme dialog box displays.
2. Press Y/v to open the drop-down list (Figure 5-89).

Color Theme

(White Background

Black Background
hite Background

Classic Background

Figure 5-89 Sample Color Theme dialog box

3. Select a function from the drop-down list.
4. Press N/X to close the dialog box.
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5.11.2 System Tools

The System Tools submenu (Figure 5-90) lets you perform system maintenance functions.
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Figure 5-90 Sample System Tools submenu

System Tool options include:

e Add Program—lets you add optional software.

¢ Update Scanner Module—\When instructed by a Help Desk representative to use, lets
you update the Scanner module files.

e System Restore—lets you reinstall your system software.

5.11.3 Easy Scroll

The Easy Scroll utility functions as a selection shortcut that lets you use only the Thumb Pad
arrows to highlight and select an item.
See “Using Easy Scroll” on page 24 for information on navigating with Easy Scroll.

B To turn Easy Scroll on and off:
e Select Utilities > Easy Scroll.
A check mark to the right of the Easy Scroll option indicates that the utility is on

(Figure 5-91).
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Figure 5-91 Easy Scroll turned on

NOTE:
Easy Scroll stays on until you manually turn it off.




5.11.4 Connect to PC

5.11.5 Run...

E] To run special CF card applications:
Insert the CF card containing the special application into CF Slot on the top of the unit

(Figure 2-3 on page 6).

2. Select Utilities > Run....

The application begins.

5.11.6 Shop Info

The Run... option is used to access special CF card applications.

Utilities

The Connect to PC selection is used with the optional ShopStream Connect™ software,
which lets you view data files on a computer and share files.

The Shop Info option lets you add personalized shop information that can be included on
printed data files.

NOTE:

A keyboard must be connected to the USB port on top of the scan tool in order to enter your
shop information.

To add Shop Info:

Select Utilities > Shop Info.
The Shop Information screen displays (Figure 5-92).
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Figure 5-92 Sample Shop Info screen

Connect a USB keyboard to the USB port on top of the scan tool, then use the keyboard

to enter information into the
Disconnect the keyboard.
Press Y/v'.

text fields.

A confirmation screen displays (Figure 5-93):
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Operations

To Print Shop Info Header at the
top of each page:

Press Y to turn on Print Header

Press N to turn off Print Header

Note: this selection will remain
in effect until changed from this
screen.

Figure 5-93 Sample shop information confirmation screen

a. Press Y/v to include shop information on printed data files.
b. Press N/X to not include the shop information on printed files.
The Shop Information screen closes.

5.11.7 System Info

The System Info option lets you view configuration information for your scan tool

(Figure 5-94).
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Figure 5-94 Sample System Info screen

B To display the System information screen:

1.

ok wDd

Select Utilities > System Info.

The System Information screen displays.

Press the down ¥ arrow to highlight the main body of the screen.
Press the right » arrow to view the next screen of information.
Press the left € arrow to return to the previous screen.

Press the N/X button to exit.



6.1

6.2

Maintenance

This section covers the following maintenance issues:

e Cleaning and damage inspection

e Battery replacement

e Storage tips

e Disposal requirements (environmental hazards)
e “Replacing the Display Window”

Cleaning and Damage Inspection

When using the scan tool, make sure to do the following:

e Before and after each use, check the housing, wiring, and connectors for dirt and
damage.

¢ At the end of each working day, clean the housing, wiring, and connectors with a clean
damp cloth.

Battery Pack

To prolong the life of your battery pack when your scan tool is not in use, power off the unit and
remove the battery pack.

6.2.1 Replacing the Battery Pack

6.3

When your battery pack no longer holds a charge, call your sales representative to order a
new one. Refer to “Using the Battery Pack” on page 19 for more details.

After you replace the old battery, call Rechargeable Battery Recycling Corporation (RBRC) at
1(800) 822-8837 (USA), or refer to their web site at http://www.rbrc.org for the nearest
recycling location and instructions for proper battery disposal.

Storage Tips

When storing your scan tool, remember the following:

e Always turn the scan tool off. See “Powering Off the Unit” on page 26 for details.

e Keep in mind the storage temperature range. See “Technical Specifications” on page 11
for details.
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Maintenance

6.4 Disposing of the Battery Pack

Always dispose of materials according to local regulations.

6.5 Replacing the Display Window

Use the optional Display Window Kit to replace the hard plastic faceplate of the scan tool.
Thoroughly clean the scan tool first, and work carefully to keep dirt out of the unit during

window replacement.

|E| To replace the display window:
1. Place the scan tool on a flat surface facing up.
2. Hold the tool steady and depress the two lock tabs at the top of the window with your
fingertips to release them (Figure 6-1).

Figure 6-1 Display window lock tabs.

Tilt the top of the window up, then lift it free from the scan tool.

Fit the three tabs on the bottom of the new window into the slots on the scan tool.
Tilt the new window down to align the top lock tabs with slots on the scan tool.
Lightly depress the lock tabs and push down to snap the window into place.

o ok w



A1

A.2

A3

Frequently Asked Questions

The following frequently asked questions provide solutions to common problems.

“Can | use my other Snap-on® test adapters with this scan tool?” on page 83

“What should | do if my printer is not responding?” on page 83

“What should | do if the unit doesn’t respond as expected when | press the Power button?”
on page 83

“Why does my unit shut down unexpectedly?” on page 84

Can | use my other Snap-on® test adapters with
this scan tool?

Yes.

What should | do if my printer is not responding?

It may take a minute or two before the printer receives the print request.
If there is still no response after a few minutes, make sure the following conditions are met:

e The printer is receiving power and is turned on.

e The printer has paper.
e The USB cable is securely connected to the scan tool and the printer.

e The USB cable is not damaged.

For related information, see the following sections:

e “Setting Up to Print” on page 25
e “Printing” on page 72

What should | do if the unit doesn’t respond as
expected when | press the Power button?

Press and hold the Power button to force the scan tool to shutdown. See “Forced Shutdown”
on page 86 for details.

83



84

A4

Frequently Asked Questions

Why does my unit shut down unexpectedly?

Your internal batteries could be low. We recommend that you check all power sources.

See “Power Supply” on page 15 for more information.



B.1

Troubleshooting

This section addresses issues that may arise when using the scan tool.

No Communication Message

When the screen displays a “NO COMMUNICATION” or “NO RESPONE FROM MODULE”
(Figure B-1) message, it means the scan tool and the vehicle control module cannot
communicate with each other for some reason.

B8 |

o=l

Chrysler 1983-2006
No communication. Is key on? Ensure
Scanner 1s connected. Wait 15 seconds.
See Appendix B in the US Domestic
vehicle communication software manual.

2006 CHRYSLER PACIFICA(AWD) 3.5L V6 MPI , 06106107 | 05:13a | A

Figure B-1 Sample No Communication message

NOTE:

Your scan tool should be powered by the vehicle, check the Status Bar (Table 4-2 on page 32).
If the vehicle power icon does not display, make sure the scan tool is properly connected (see
“Connecting to Vehicle Power” on page 21). If vehicle power is still not available, check for
circuit problems on the vehicle.

The following conditions will cause the scan tool to display a no communication message:

e The scan tool is unable to establish a communication link with the vehicle.
® You are using the incorrect Personality Key™ device with the test adapter.

® You select a system for testing that is not part of the vehicle equipment (for example—ABS
on a vehicle without antilock brakes).

e There is a loose connection.

e There is a blown vehicle fuse.

e There is a wiring fault on the vehicle.

® Incorrect vehicle identification is entered.

Refer to the appropriate Vehicle Communication Software User’s Manual, included on the
documentation CD, for manufacturer-specific problems.
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Troubleshooting

B.2 Battery Pack Not Charging

If the battery pack does not charge:

The battery pack may not be installed in the battery charger unit properly.

Make sure the battery charger unit is receiving power; and, without using force, adjust the
battery pack installation in the battery charger unit until the red status light displays.

The battery pack may be too hot.

Allow the battery pack to cool to at least 104°F (40°C). If left in the battery charger unit,
once the proper room temperature is achieved, charging will begin.

The battery pack may be too cold.

Allow the battery pack to warm to at least 32°F (0°C). If left in the battery charger unit,
once the proper room temperature is achieved, charging will begin.

The battery pack may be dead.

The battery pack must be replaced. See “Replacing the Battery Pack” on page 81. Use
another power source to continue working. See “Power Supply” on page 15.

B.3 Unit Will Not Power On

The following conditions will prevent your scan tool from powering on:

No or expired battery pack (see “Battery Pack” on page 16)

You are connected to a vehicle diagnostic connector that does not supply power, requiring
the auxiliary power cables (see “Auxiliary Power Cables” on page 18 and “Vehicle Power”
on page 16)

B.4 Forced Shutdown

If your scan tool freezes or will not power off, you can perform a forced shutdown.

E] To perform a forced shutdown:

1.
2.

Press and hold down the Power button for five seconds.
The scan tool sounds a series of beeps, then turns off.
The unit can now be restarted.



B.5 Beep Codes

Beep Codes

The scan tool contains a tone generator that produces a series of audible tones, or beeps, to

alert the user to certain operating conditions. Use the table below to interpret beep codes:

Table B-1 Beep code definitions

Function

Beep Code

Power up

Short beep

Forced shutdown

Short beep—pause—three double beeps—pause—extra long beep

Normal shutdown

Short beep (button pressed)—extra long beep (at power down)

Low internal battery turn on

Six long beeps

Low internal battery shutdown

Extra long beep

Short beep = 80 ms, long beep = 100 ms, extra long beep = 1000 ms.
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A

AC power adapter, 17

actuator tests, 38

adapters. See test adapters

auto scroll, 69

auxiliary power cables
battery power cable, 18
lighter power cable, 18
vehicle power, 16, 21

battery pack

about, 16

charger, 16

charging, 23

disposing of, 81

extending the life of, 24

installing, 24

low battery warning, 24

not charging, 86

replacing, 81

time to charge, 23

using, 22-24

working when battery is low, 24
battery pack specifications, 11
battery power cable. See auxiliary power cables
baud rate, 48
beep code definitions, 87
brightness/contrast, 10, 27

See also buttons
buttons, 10, 13

cables, 17
casing hook, 11
changing screen views, 55-60
See also upper toolbar
cleaning the unit, 81
clearing a frame of held data, 41
clearing codes, 46
Codes & Data selections, 38
See also data parameters
Codes Menu, 38, 45-47
codes. See diagnostic trouble codes (DTCs)
color theme setting, 77
CompactFlash®
and software updates, 78

CompactFlash® cards
application, 79
slot locations, 10
slot technical specs, 11
special applications, 79
component tests, 38, 47
confirmation messages, 33
connecting to a computer, 26
connecting to a vehicle, 35, 38
connecting to vehicle power, 21
copying data, 70
cursors, 63
custom setup, 39, 52
customizing a data list, 41

D

damage inspection, 81
data cable, 18
See also power supply
data cable connector, 10, 15
data cable extension
accessory, 18
Data Display, 38
Data Display selections, 39-45
Data Management screen, 67
data parameters
and LED indicators, 43
changing views, 55
customizing list, 41
displaying, 38, 45
fixing, 40
Graph views, 57
locking, 40
pausing, 63
PID List view, 55
reviewing, 56
Text view, 57
data storage CF card, 11
date setting, 75
DC power input
AC/DC power supply, 15
DC power jack
location, 10
deleting saved files, 70
demonstration programs, 53
diagnostic trouble codes (DTCs), 38
disposal requirements, 81
DTC status, 46
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Easy Scroll, 32, 78
error messages, 33
exit menu
options, 41-46
exiting Scanner mode, 54

F

fixing/releasing data lines, 40
forced shut down, 86

Freeze Frame/Failure Records, 46
frequently asked questions, 83
Full PID List option. See printing
Full Screen option. See printing
functional tests, 38, 47

G

generic functions, 39, 48

getting started, 19

graphing data, 55-64
changing views, 55
Graph mode, 57-60
parameter menu, 58

H

handgrips, 10
hanging position. See stand
holding a frame of data, 40—41

identifying a test vehicle, 35, 37
information tests, 47
inspecting unit for damage, 81

L

LCD screen, 10

LED indicators, 29, 31
changing assignments, 43
monitoring parameters, 43

lighter power cable. See auxiliary power cables

loading saved data, 69
lock PID, 56
locking data parameters, 40, 58

main body, 31
Main Menu (System), 38
maintenance

battery pack, 81
maintenance tips, 81
making selections, 32

90

manual conventions

description, 5

notes, 6
manuals, software, 7
manufacturer selection (vehicle), 35, 36
Min/Max values, resetting, 64
Mini USB port

connecting to PC, 15
movies, 48-51

arming, 43, 48

erasing, 49

printing, 42

recording, 39, 48-50

viewing, 50-51
moving saved data, 70

navigating, 29-32

(0

operating temperature range, 12

operations, 35
connecting to a vehicle, 35, 38
identifying a test vehicle, 35, 37
selecting a system to test, 35, 37
selecting software, 35, 36
selecting tests, 35, 38

optional accessories, 18

P

parameter menu, 58

clear all trigger levels, 58

clear trigger levels, 58

lock, 58

scale, 58

set trigger levels, 58
parameters. See data parameters
Pause/Play button. See upper toolbar
pausing data, 56, 63
PC, connect to, 79
Personality Key™, 85
PID lists

locking, 56

unlocking, 57
PID triggering, 61
PIDs. See data parameters
Play button. See upper toolbar
Power button. See buttons
power cables. See auxiliary power cables
Power Management options, 73
power options, 26



power supply
connecting to, 21-25
connecting to vehicle power, 21
types, 15-17
powering up the unit, 25
pressure units, customizing, 52
printer setup, 25
printing, 72
data, 42-43
options, 42

R

recording movies. See movies

reset tests, 48

returning to a Codes & Data screen, 41
review, 69

review PID, 56

S button, 14
location, 10
See also Utilities
S button setting, 76

Safety, iii—iv
safety

information, iii

message conventions, iii
safety messages, iii—iv

saved data, 67-71
identifying, 68
viewing, 67
saving data, 65-67
scale PIDs, 60
scanner button, 30
Scanner mode
exiting, 54
screen layout, 29
screen messages, 33
selecting a system to test, 35, 37
selecting software, 36
selecting tests, 35
self-tests, 38
service codes, 38
set trigger levels, 60-61
Shop Info, 79
ShopStream Connect, 26
shutting down the unit, 14, 26
snapshot preferences, adjusting, 74
software
exiting, 53
selecting, 35, 36
Troubleshooter, 9, 53
Vehicle Communication, 9
software manuals, 7

software updates, 78
speed units, customizing, 52
stand, 11, 12-13
Status Bar, 31
storage temperature range, 12
storage tips, 81
subsystem tests, 47
supplying power. See power supply
System Info option. See Utilities menu
system information

displaying, 80

Utilities button, 72
system tests, 39, 47

T

Technical specifications, 11-12
temperature range specifications, 12
temperature units, customizing, 52
terminating vehicle communication, 53
test adapters, 18, 21, 22, 85
tests

actuator, 38

component, 38, 47

functional, 38, 47

selecting, 35, 38

subsystem, 47

system, 39, 47
Thumb Pad, 10, 13

See also buttons
time setting, 75
time zone setting, 76
toggle tests, 48
tool setup

save data, 74
Tool Setup menu. See Utilities menu
toolbar. See upper toolbar
trigger

clearing levels, 62

condition, 61

delay, 61

disarming, 62

point, 48

See also movies
Trouble Codes, 46

trouble codes. See diagnostic trouble codes (DTCs)

Troubleshooter, 39, 51
troubleshooting tips, 85
turning off the unit, 26

U

unit operations. See operations
unlock all, 57, 58

unlock all PIDs, 59

unlock PIDS, 59
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upper toolbar
buttons and functions, 29
Cursor button, 63
navigating, 32
Pause/Play button, 56
Print button, 72
test controls, 29
View button, 55

USB port
connecting to PC, 15
location, 10

Utilities menu, 72
Connect to PC, 79
Easy Scroll, 78
Run..., 79
Shop Info, 79
software update, 78
System Info, 80
Tool Setup menu, 73-77

\')

variable control tests, 48

Vehicle Communication menu, 36

vehicle diagnostic connectors, 18, 21, 38

vehicle identification. See identifying a test vehicle
vehicle power. See power supply

w

warning messages, 33

Y button. See buttons
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